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Section A:
Understanding Design in v8
Read This First
This section gives an overview of how design works in v8.

Note: If you haven't looked at design before, it is a good idea to go to 'Help | Starter Guide' in Actinic to open the 'Getting Started' guide. This guide contains some more in-depth explanations of how design works, with some worked examples.

With Actinic v8 there are a set of basic rules and principles governing the design of your Actinic site. Once you master these rules, you will have the ability to change the look and functionality of every Actinic page as you see fit.

Here are the rules:
Choosing Alternative Layouts

If you look at the 'Layout' tab in 'Settings | Site Options' (or the 'Layout' tab in any section or product) you will see 'layout settings', with a range of alternative layouts to choose from. You can use these settings to change the layout of elements within Actinic.
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When the value in a layout setting says 'Use Parent', this means the value is come from somewhere 'higher up' in the store structure – click in the layout setting and it will tell you where the value is coming from in the area underneath the grid.
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You can often select '<New>' at the bottom of the list to create your own custom layouts based on the existing ones.

Click on Anything to Customise It
Within the 'Design' tab, you can click on anything in the preview, and the code that lays out that item will appear underneath it.
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You can then make a change to the HTML, and click 'Apply' and you will be able to immediately see the results.

If you are unhappy with a change, click the 'Undo' button on the toolbar -  [image: image5.bmp] - to reverse out the change.

Variables

The blue and underlined pieces of text in the design are variables. 
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These get substituted for data within Actinic when the store pages are previewed or generated before an upload. Use the 'Insert Variable' button - [image: image7.png]Q@



 - to add a variable into the design.

If you ever want to find out what a variable does, you can look it up in the 'Variable Reference Guide' in 'Help | Variable Reference Guide' in Actinic. 

[image: image8.png]E? Variable Reference Guide

5 o« Jeig

Hide Back Pirt Options

Conterts | Index | Search CancelButton

= (@) oot
[2] Usig Thi Guide
= () Varisles By Product Area
mo Attbutes Type of yarisble: Text
@ Brochue Pages
@ Brochure Pages > Navigaion
= (0 Checkou
@ 2] AddessBook Place of Setting: Design | Text

psinitonn
e Design Text Reference: Phase: 1, 101 505
[2] AppletPageTile

[2] AppletParams
[2] BackButton

Text for cancel button

Related Product Area: Checkout

2] Checkoutrea
2] Checkouutons

2] CreckouLapout
B e





It is possible to add custom variables to Actinic. These are known as 'user-definable variables'. The value of a user-definable variable is set within a grid like this:
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You can edit user-definable variables by going to 'Design | Library' and then looking at the 'Variables' tab. The group that the variable is in will be the same as the sub-heading in the grid where you set the value of the variable.
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You can add new user-definable variables by clicking the 'Insert Variable' button and then clicking the 'New' button.
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Layouts

When you click on something in the preview, you are selecting a 'layout'. Everything you see within the Actinic store pages has a layout that controls its appearance. You can see the name of the layout within the title bar of the layout code panel.

[image: image12.png]; Layout Code - Standard Search Price Band

1 <option value=’SearchPriceBandIndex">
SearchPriceBandMin hlock if- SearchPrice
3 </option>





Where you see a purple and underlined piece of text within a layout, this shows you where a layout is being inserted within a layout. You can right-click on the purple text and select 'Navigate To' to look at the inserted layout.
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If you are looking at a layout and you want to go 'up one level' in the design (i.e. see the layout that your current layout is inserted within) then click the 'Navigate to Parent Layout' button on the toolbar below the layout the code:

[image: image14.bmp] 
The very 'top' layout used by a page is the 'overall page layout'. This is the layout that inserts all the branding and navigation across the top/bottom and down the sides of each page.

The Library And Design Tree
The complete range of layouts in Actinic is in 'Design | Library' in the 'Layouts' tab. Layouts are grouped into 'types'. To find a layout, right-click anywhere in the library and select 'Find'.
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You can right-click on a layout and select 'New Layout' to create a new layout.
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Finally, you can right-click on a layout and select 'Revert to Factory Settings'  - this changes a layout back to how it was when you first started using Actinic.
Conditions

When you see green 'block' tags in the design, these are called 'conditional blocks'.
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These block tags contain a condition, and the condition must be 'true' in order for the code between the block tags to appear. To see the condition, double-click on the opening 'block' tag.
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You can add your own conditions into the design by highlighting a piece of code and selecting the 'Insert Block' button on the layout code toolbar - [image: image19.bmp].

If you want to apply a condition to hide/show a single variable, then you don't need to use block tags. You can just right-click on the variable, select 'Edit Appearance', and then select the '<Edit Expression>' option in the 'Condition' field. 
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In the 'Conditions' tab of 'Design | Library', there are reusable conditions. You can create a new condition here (by right-clicking and selecting 'New Condition') then give the condition a name, set up the rules for it, and you will be able to use this condition in multiple places in your store.
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Layout Selectors

If you look in the 'Layouts' tab of the library, you'll see that every layout 'type' contains at least one 'layout selector'. These layout selectors are the things that actually insert the layouts within each other – they are the glue that holds the entire Actinic design together – i.e. when you see a purple and underlined piece of text in a layout, you are looking at the representation of a layout selector.
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If you click the 'Insert Layout' button on the layout code toolbar, you will be given a list of layout selectors to insert into the design. Sometimes there is a one-to-one relationship between a layout selector and a certain layout – for example, the layout select 'SearchResult' will only ever insert the layout 'Standard Search Result' into a layout. Most layout selectors, however, can potentially insert one of a number of layouts. Where there is a choice, you can usually select the layout to be used in 'Settings | Site Options | Layout', or in the 'Layout' tab of a section/product/fragment etc.
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If you know which layout you want to insert, then when you are inserting a layout selector, select the 'Use Fixed Layout' checkbox, and select the layout you want to insert into the design. This means you can no longer control the layout via 'Site Options' or wherever.
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When you use a fixed layout, the name of the layout is inserted in the design:
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Without a fixed layout, the name of the layout selector is inserted into the design:
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To edit the fixed layout inserted by a layout selector, right-click on the selector and select 'Edit Appearance'.

Content Lists

Lists are used when there is more than one of an item to be inserted into the page e.g. if there are 10 products to be inserted into a page. Lists contain the code that goes between each item in the list, and also at the top and bottom of the list.
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The easiest way to edit a list is to click on an item that is being laid out by a list, and then click the 'Navigate to Parent Layout Button' in the layout code toolbar - [image: image30.bmp]
You can tell you are looking at a list when there is an orange 'Click here to edit list layout settings' link at the top of the layout code, and an 'Edit List Layout Settings' button appears.
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Click either of these to edit the code of the list.
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The 'Overall Design' tab has the code that goes at the start and end of the list, and the 'Edit Rows and Columns' tab contains the code that goes before and after each item in the list.
Section B – Design Tricks for Layouts
Making Sure Images in the CSS Appear Correctly

When you include an image in the 'Actinic Stylesheet' layout, or in another custom *.css file you are using, make sure you include single quotes in the code e.g...

background-image: url(background.gif);

...will not work. But...

background-image: url('background.gif');

... will ensure the image is picked up by Actinic and will be uploaded and previewed correctly.

Hiding Code From The Preview

Sometimes you will have some code in your designs (e.g. an affiliate tracking scheme) that will only work online, and may actually have an adverse effect on the performance of the preview.

If this is the case, it is possible hide it from appearing in the preview with a condition. The code will then only be included in the store pages in the online store.

To do this, highlight the code you want to hide in the 'Layout Code' panel in the 'Design' tab, and then click the 'Insert Condition' button (green 'C' with a '+').

Use the following condition:

 [image: image34.png]



Here is some code to copy and paste to create the condition:

<actinic:variable name="IsPreviewMode" /> == false
Then click 'OK' and click 'Apply' in the 'Layout Code' panel, and the code should vanish from the preview. It will be there in the online store though.
Changing The CSS Layout To Be An External File

All the CSS classes for Actinic are within a layout called 'Actinic StyleSheet'. However, some users prefer to edit the CSS file in an external editor such as Dreamweaver or TopStyle. This exercise will show you a quick way to make the CSS file accessible via an external editor.

The first thing you are going to do is create a blank *.css file in your 'Site1' folder.

1. Start 'Notepad'.

2. Save your blank file straight away into your 'Site1' (or equivalent) folder with a filename of 'custom.css'.
You now need to copy the contents of the Actinic StyleSheet into this file.

3. Go to 'Actinic' and go to the 'Design' tab.

4. From the 'Select Page Type' menu, select 'Actinic StyleSheet'. 
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5. Right-click in this layout and select 'Select All'. 

6. Copy all the highlighted contents to the clipboard.

7. Now switch to Notepad and paste the contents of the clipboard into the empty stylesheet.
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8. Save this file as 'custom.css'.

You can now link to this file from within Actinic.

9. Now go back to the 'Actinic StyleSheet' layout.

10. Delete everything in this file apart from the following line (in line 2):

@import url("theme.css");

11. Now change this line to read:

@import url("custom.css");

12. Click 'Apply'.

This won't have any visible effect in Actinic yet, but it means you can now edit the file in an external editor.

Inserting Content to Only Appear on the Store Front Page

If you want a message or an image to appear on the front page of the store, but no other page, then do the following:

1. Change the preview to show the front page of the store. This is the 'Online Catalogue' icon in the content tree.

2. Select the 'Main Product Area Layout' in the 'Design' tab. This will be called something like 'Standard Section Page' or 'Section Page With Section Name At The Top'. The easiest way to do this is to click on anything in the main part of a section page and then keep pressing the 'Navigate to Parent Layout' button  - [image: image37.bmp] - until the correct layout is selected.

3. Insert your content that you only want to appear on the front page. 

4. Once you have got it looking correct, highlight all the content and press the 'Insert Block' button on the toolbar - [image: image38.bmp].

5. The condition to enter is:

<actinic:variable name="SectionLevel" /> == 0
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6. Click 'OK' and then click 'Apply' to save the changes to your layout.

Your content will now only appear on the store front page.

Creating a Listing Page which Links Through to Full Details Pages

Actinic has the ability to generate 'Extended Information' pages for the products in your store. These are normally generated as pop-up windows – containing a larger image or a longer description. It is possible, however, to also include an add to cart button in these pages and make the page look like a standard page – rather than a special pop-up page.

Doing this means that one product can appear twice in the store – very useful if you want to have compact product listings (with 'add to cart' buttons) which link to a full information page for each product (also with 'add to cart' buttons).

This exercise will show you the basics of setting this up. It is based on the 'Starter Computer Bundle' product in the default Actinic store database – but it will work with any product that has a extended information page defined. 

1. Go to the 'Starter Computer Bundle' in the content tree.
2. Change to the 'Extended Information' tab.
3. In the grid at the bottom, change the 'Extended Info Page Design' to 'Includes Add To Cart Button'. 
4. Also, change the 'Type of Extended Information Page' to 'Opens In The Same Window'.
5. Click 'Apply changes'.
6. Click the 'Preview' button in the 'Extended Info Page Design' field to show you what the page design looks like at the moment.
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7. Now click the [image: image41.bmp] button to generate a full site preview. 
Browse to the 'Computers' section and click the 'More Info' link at the bottom of the store description.
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The page looks very plain at the moment, with no navigation. The next job is to customise this page to make it look like a normal store page.

This really depends on what theme you are using – but here are some general directions.

1. In the 'Design' tab of your store, locate the 'overall page layout' for your page.

2. Find the 'INNERLAYOUT' layout selector within this page.

3. Highlight everything above this layout selector and copy it to the clipboard.

4. Go to 'Design | Library | Layouts' and find the 'Extended Info Layout' layout type group.

5. Find the 'Includes Add To Cart Button' layout in this group, and double-click on it to open it.

6. Highlight everything in this layout down to (but NOT including) the <form> tag on line 21.
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7. Right-click on the highlighted code and select 'Paste'. 
8. Click 'OK' to confirm your layout changes and close the layout.
This has changed the appearance of the top of the page. Now you need to change the appearance at the bottom of the page.
9. Close the library and go back to the overall page layout code in the Design tab.
10. Highlight everything below 'INNERLAYOUT' down to the bottom of the file.
11. Right-click on the highlighted code and select 'Copy'.
12. Now go back to the 'Includes Add To Cart Button' layout in the library.
13. Scroll right down to the bottom of the file.
14. Highlight the </body> and </html> tags that are at the bottom.
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15. Right-click on the highlighted code and select 'Paste'.
16. Click 'OK' to confirm your changes and close the layout.
You have now applied the 'overall page layout' design to your extended information page layout.
To test this, carry out a full site preview by clicking the [image: image45.bmp] button.
Only Displaying the First Ten Words of the Full Description

It is possible to include a PHP statement which only displays the first 10 words of the full description in the store pages. This is useful if you are displaying a compact version of the product, and don't want the full description to appear.

Simply click on the product description (in the 'Design' tab) that you want to shorten. 

Then locate the 'ProductDescription' variable in the layout code.

Highlight that variable and replace it with the following code:

<actinic:block php="true" >

$sShort = "";

$nCount = 0;

$sOriginal = '<actinic:variable encoding="perl" name="ProductDescription" selectable="false" />'; 

foreach(explode(" ", $sOriginal) as $sWord)


{

   if ($nCount > 10)

   
{

   
$sShort .= "...";

   
break;

   
}

   $sShort .= $sWord . " ";

   $nCount++;

   }

echo $sShort;

</actinic:block>
Including the Stock Level into the Store Pages

To include the current stock level against a product, click on a product in the 'Design' tab to bring up the layout code for that product and then insert the 'StockLevel' variable into the code.
You can incorporate the 'StockLevel' variable into a condition to show/hide different messages based on the stock level.

This exercise will show you how to include a stock message that will only appear if the product is stock monitored and there is less than 10 of them in stock.

1. In the Design tab, select any product layout by clicking on a product name.
2. Scroll to the bottom of the layout code of that product layout until you find 'ProductRelatedProductsList'.
3. Add a blank line just below this line.
4. Insert a <br /> into this line.
5. Then enter the following text 'This product is running low on stock. Please call us to check availability'.
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6. Click 'Apply'. The text should appear for some or all of the products on this page.
7. Now highlight the entire line you entered and click the 'Insert Block' button on the layout code toolbar - [image: image47.bmp]
8. This will open the 'Expression Editor'.
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You are going to create a condition that says 'the product is stock monitored AND there is less than 10 of them in stock'.

9. Start typing 'IsStock...'. You should see Actinic prompting you to insert a variable. Select 'IsStockMonitored' by pressing 'Enter' on your keyboard.
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10. Now click the 'Insert an operator into expression' button and select 'And' from the drop-down list provided.
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11. Type a standard left bracket - '('

12. Now start typing 'StockLevel'. When Actinic prompts you to enter the 'StockLevel' variable into the design, press 'Enter' on your keyboard.

13. From the 'Insert Operator...' list, select 'Less Than'.

14. Now type '10' (without the quotes) and enter a standard right bracket - ')'
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15. Click 'OK'.

16. Click 'Apply' to confirm the changes.
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Now change to the 'Content' tab to test this change. 

1. Go to any product in the content tree and go to the 'Stock' tab.

2. Select 'Stock Monitoring' and enter an 'Estimated Stock In Hand' of '6'. 

3. Click 'Apply changes'. The stock message should be visible in the preview. It will be underneath your list of 'also bought' products, if you have one displayed.
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4. Now change the 'Estimated Stock In Hand' to '20' and click 'Apply changes'.

5. The stock message should disappear.
Changing the Way Attributes are Laid Out

To lay out attributes side by side, rather than one underneath the other, go to the 'Layout' tab of the product that the attributes are within, and set the 'Column Count For Attributes' to something other than 'Use Parent'.
If you want to display different attributes in different parts of your product layout, rather than all in the same place, then do the following:

1. Go to 'Design | Library | Layouts' and locate the 'Attribute Lists' Group.

2. Right-click on 'Standard Attribute List' and select 'New Layout'.

3. Call this new layout 'First Attribute'.
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What you are going to do now is set a condition in the new list layout so that 'First Attribute' only displays the first attribute in the list. 

4. Double-click on the 'First Attribute' layout.

5. Right-click on the 'AttributeLayout' layout selector and select 'Edit Appearance'.

6. Under 'Condition', select '<Edit Expression>'.
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7. The expression you need to enter is: ListIndex == 1

Feel free to copy and paste the following code to create the expression:

<actinic:variable name="ListIndex" /> == 1

8. Now right-click on 'First Attribute' and select 'New Layout'. Call this new layout 'Second Attribute'.
9. Now edit the code of the 'Second Attribute' list layout and edit the condition on 'AttributeLayout' so it reads 'ListIndex == 2'.

10. Finally, create a 'Third Attribute' list layout and put a condition on 'AttributeLayout' of 'ListIndex == 3'.
You are now ready to use these new list layouts.

11. Exit the library and go into the 'Design' tab.

12. Locate 'AttributeList' within the layout code of a product.

13. Delete this. 
14. In its place, click the 'Insert Layout' button.

15. Select 'AttributeList' in the top list and select 'Use Fixed Layout'. Select 'First Attribute' in the bottom list.
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16. You can now insert 'Second Attribute' and 'Third Attribute' in the same way.
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17. Now put the different layout selectors in different parts of your design, depending on where you want the attributes to appear.
Displaying Images Against Radio Button Choices

It is possible to display an image against each radio button choice.

This change will include a new field for your choices called 'Image', and whatever image you specify there will be displayed next to the radio button for that choice in the web page. 

To begin, go to 'Design | Library | Variables'. Then right click on the 'Choices' group and select 'New Variable'.

Use the following settings for the new variable:

	Name
	ChoiceImage

	Description
	An image to use with this choice.

	Prompt
	Image

	Group
	<leave as 'Choice'>

	Place of Setting
	Choice

	Allow <Use Parent>...
	<unchecked>

	Tab Name
	General

	Type
	Filename

	Allow Empty Value
	Checked

	Initial Value
	<blank>

	Top Level Value
	<blank>


Then click 'OK' and change to the 'Layouts' tab of the library.
Open the 'Choices' layout group and and double-click on the layout called 'Radio Button Choice'. Replace all the code with the following:
<input type="radio" name="<Actinic:Variable Name="UIWidgetName"/>" value="<Actinic:Variable Name="ChoiceSelectedValue"/>"<actinic:block if="%3cactinic%3avariable%20name%3d%22ListIndex%22%20%2f%3e%20%3d%3d%201">checked="checked"</actinic:block> />

<Actinic:Variable Name="ChoiceDisplayLabel"/><actinic:block php="true">


$choiceimage = '<Actinic:Variable Name="ChoiceImage" encoding="perl" selectable="false" />';


if ( $choiceimage )



{



list($width, $height, $type, $attr) = getimagesize($choiceimage);



if ( $width )




{




echo " <img src=\"$choiceimage\" width=\"$width\" height=\"$height\" />";




}



else




{




echo "<font color=\"red\"><b> BAD IMAGE</b></font>";




}



}

</actinic:block>&nbsp;&nbsp;

Click 'OK' and close the Library, and that's it.

Your 'Choice Details' dialogue should now have a new entry ' Image', where you can browse for an image to add to this choice.
Displaying Fragments Separately From Products

By default, fragments within a section are laid out by the 'Standard Product List' layout (or the 'Product List With Horizontal Dividers' layout if you are using that one). So therefore all fragments and products are laid out as a single list.

It is possible though to create a list that just does products, and a list that just does fragments, and then include them in different parts of your design.

To begin, you need to find out what kind of product list layout you are using. To do this:

1. Go to 'Settings | Site Options | Layout'

2. Under the 'Product' sub-heading, locate the 'Product List Layout' field.

3. Make a note of the layout that is selected in the field.

You can now edit this layout.

1. Now go to 'Design | Library | Layouts' and expand the 'Product Lists' group.
2. Right-click on the list layout you are using in your store and select 'New Layout'.

3. Give the new layout a name of 'Section Fragment List' and click 'OK'.

4. Double-click on this layout to edit it.

5. Delete everything in this layout down to line '15' (i.e. remove the references to 'ProductLayout' but leave the references to 'FragmentLayout').
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6. You now need to highlight all the code in this layout and then click the 'Insert Block' button: [image: image59.bmp]
7. Enter the following condition:

[image: image60.png]ProductType





You can copy and paste the following code to create the condition:

<actinic:variable name="ProductType" /> == 2
8. Click 'OK' to save the condition, and then click 'Apply' and then 'OK' to save the changes to the list layout.

9. Now double-click on the product list layout that your store is using.

10. Delete everything AFTER line 15 (i.e. remove the references to 'FragmentLayout' but leave the references to 'ProductLayout')

11. Now highlight all this code and again click the 'Insert Block' button: [image: image61.bmp]
12. This time, use the following condition:
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If you prefer, you can copy and paste the following code:

(<actinic:variable name="ProductType" /> == 0) OR (<actinic:variable name="ProductType" /> == 1)

13. Click 'OK' to save the condition, and then click 'Apply' and then 'OK' to close the layout.

 You have now created two different layouts. Your next job is to include those layouts into the design of your section pages. 

14. Close the library and switch to the 'Design' tab.

15. Make sure you are looking at a section that contains both fragments and products. You should find that the fragments within the section are not appearing.

16. Click anywhere within the main part of the section page (e.g. on a product).

17. Press the 'Navigate to parent layout' button (yellow spiral with up arrow) until you are in a layout called something like 'Standard Section Page' or 'Section Page With Section Name At The Top'.

18. Within this layout, locate the pink 'ProductList' selector:
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This shows you where your products are being inserted into the design. You can move this to a different location within the layout if you want.
To insert your list of fragments into the design:

1. Click the 'Insert Layout' button - [image: image64.bmp]
2. From the top list select 'ProductList' and select 'Use Fixed Layout'.

3. From the bottom list select 'Section Fragment List' and click 'Insert'.

This will insert the list of fragments into the design.
Creating Additional Pop-Up Windows

It is possible to create additional extended information pages for the products in your store, containing different information from the standard pages.

This exercise will take you through creating a second extended information page.

To begin with, you are going to create the layout and layout selector for the extra information page.

1. Right-click on any of the layout type groups in the 'Layouts' tab and select 'New Layout Type'.

2. Give it a name of 'Extended Info Layout 2' and ensure you select 'Pop-up'.
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3. Click 'OK'.

4. Right-click on this new layout type group and select 'New Layout'.

5. Give it a name of 'Extra Information Page' and click 'OK'.

6. Now double-click on this layout to edit it.

7. Click the 'Edit Layout Details' button.

8. Change the value in the 'Extended Info Page Filename Field' from:

<Actinic:Variable Name="ExtendedInfoPageName"/>
to:

<actinic:variable name="ProductReference"/>_alt_popup.html
9. Click 'OK'.

This will automatically use a filename for the second information pages of the product reference, followed by '_alt_popup.html'.

Now you need to put some layout code into this layout. The best way to do this is to go into one of the layouts in the existing 'Extended Info Layout' group and copy and paste the content from there into the new 'Extra Information Page' layout. You can amend this as necessary.

You now need to create a layout selector to include the new 'Extra Information Page' into the store design.
1. Right-click on the 'Extended Info Layout 2' group and select 'New Selector'.

2. Give it a name of 'AltInformationPage'.

3. Give it a prompt of 'Layout for Second Information Page'.

4. Under 'Place of Setting', select 'Site', 'Section' and 'Product' and set the 'Tab Name' to 'Extended Information'.

5. Change to the 'Values' tab.

6. Highlight 'Extra Information Page' in the left list and click the '>' button to move it to the right-list.

7. Change back to the 'Basic Definition' tab.
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8. Click 'OK'.

Next you need to create a new 'true/false' variable that you can use to turn on the second extended information page.

1. Change to the 'Variables' tab of the library.

2. Right-click on the 'Other' group and select 'New Variable'.

3. Give the variable a 'Name' of 'ShowSecondPopUp'.

4. Give it a 'Description' of 'Change this to 'True' to use the second pop-up page'.

5. Change the 'Prompt' to 'Enable Second Pop-Up Page?'

6. Under 'Place Of Setting' select 'Product'.

7. Change the 'Tab Name' to 'Extended Information'.

8. De-select 'Allow <Use Parent> as an Option'.

9. Change 'Type' to 'True/False'.

10. Change the 'Inital Value' and 'Top Level Value' both to 'False'.
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11. Click 'OK' and close the library.

You are now ready to create a link to your extra information page.

1. Close the library and look at the 'Design' tab. 

2. Select a product that you want to include this second information link for.

3. Copy and paste the following code somewhere in the product layout:

<actinic:block if="%3cactinic%3avariable%20name%3d%22ShowSecondPopUp%22%20%2f%3e" >

<actinic:variable name="AltInformationPage" />

<br />

<a href="javascript:ShowPopUp('<actinic:variable name="ProductReference"/>_alt_popup.html',400,400);">Click here to launch extra information page</a>

</actinic:block>
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The 400 values are for the width and height of the window – so feel free to amend these values accordingly.

All you need to do now is set 'Enable Second Pop-Up Page?' to 'True' (in the 'Extended Information' tab of the product) and Actinic will insert the link for the second information page.

Currently the page will contain the same content as a standard extended information window – so edit the layout of 'Extra Information Page' as you see fit. Also, you can create additional layouts within the 'Extended Info Layout 2' group to create a range of alternative extended information pages for your products.

Pop-Up Windows That Automatically Resize to Fit the Images Within Them

The code below can be used for an 'extended information' page layout. It works by creating a pop-up window that will automatically resize to the dimensions of the image that is within the pop-up window.

To use this code, go to 'Design | Library | Layouts' and expand the 'Extended Info Layout' group. Right-click on any existing layout in that group and select 'New Layout'. Give your new layout a name of 'Auto-Resizing Layout' and click 'OK'.

Once your new layout is created in the library, double-click on it to open it and replace all the code within it with the HTML below...

<html>

<head>

<Actinic:WINDOW width="<Actinic:Variable Name="ExtendedInfoImageWidth"/>" height="<Actinic:Variable Name="ExtendedInfoImageHeight"/>"/>

   <title><actinic:variable name="PageTitle" /></title>

   <actinic:variable name="BaseHref" />

    <script language='javascript'>


  var arrTemp=self.location.href.split("?");


  var picUrl = (arrTemp.length>0)?arrTemp[1]:""; 


  var NS = (navigator.appName=="Netscape")?true:false; 


  function FitPic()
   {


   iWidth = (NS)?window.innerWidth:document.body.clientWidth; 


   iHeight = (NS)?window.innerHeight:document.body.clientHeight; 


   iWidth = document.images[0].width - iWidth; 


   iHeight = document.images[0].height - iHeight; 


   window.resizeBy(iWidth, iHeight); self.focus(); }; 


</script>

</head>

<body bgcolor="#000000" onload='FitPic();' topmargin="0" marginheight="0" leftmargin="0" marginwidth="0">

  <script language='javascript'>

    document.write( "<a href=\"javascript:window.close();\"><img src=\"<Actinic:Variable Name="ExtendedInfoImage"/>\" width=\"<Actinic:Variable Name="ExtendedInfoImageWidth"/>\" height=\"<Actinic:Variable Name="ExtendedInfoImageHeight"/>\" border=\"0\"></a>" );

  </script>

</body>

</html>

Click 'OK' to save your changes when done.

Your new layout will be available to select within the 'Extended Information' tab of 'Site Options' or within your products/sections.
Selecting Quantity From A Drop-Down 

This technique will replace the usual text field for entering a product quantity on the product page, with a drop-down list for customers to select how many they want.

Go to a store page where you can see a 'Quantity' field. Click on the 'Quantity' text – and just after it, you should see this line:
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Replace HTML tag with the following:

<select name="Q_<Actinic:Variable Name="ProductReference"/>"><option selected value="<Actinic:Variable Name="DefaultQuantity"/>">1</option><option value="2">2</option><option value="3">3</option><option value="4">4</option><option value="5">5</option><option value="6">6</option><option value="7">7</option><option value="8">8</option><option value="9">9</option></select>
This code contains options up to '9' – but you can easily adapt it for more or fewer items.
Including an 'Email A Friend' Link into Actinic

Enter the following code into your product layout:

Enter e-mail address to tell a friend
<input type=text value="" size=40 onchange="

var thisloc=location.href + '#<Actinic:Variable Name="EncodedProductAnchor"/>';

if (this.value != '') {


location.href='mailto:' + this.value +'?subject=Take%20a%20look%20at%20<Actinic:Variable Name="ProductName"/>&body=I%20saw%20' + thisloc + '%20and%20thought%20you%20would%20be%20interested.'


}
">
<input type=button value="OK">

Displaying Store Prices In Three Currencies

This solution will display a third currency alongside the two currencies you are already displaying (this is enabled in 'Settings | Business Settings | Options').
To insert the third currency, simply click on a price in the 'Design' tab. You should highlight a layout called something like 'Product Price Including Tax' or 'Product Price Excluding Tax'.

Replace the code in the layout with the following:

<actinic:block PHP='true' SELECTABLE='false'>

priceformat('<actinic:variable name="SecondCurrencyFormat"/>','<Actinic:Variable Name="TaxExclusivePrice"/>', '<actinic:variable name="TaxExclusivePriceAlt" />');

$nExchangeRate = 2.5;

$sCurrencySymbol = "$";

$nDecimals = 2;

$sDecimalSep = ".";

$sThousandsSep = ",";

echo "/ "; 

formattedcurrency($nExchangeRate * <actinic:variable encoding="perl" name="ProductPriceRaw" selectable="false" />, $nDecimals, $sDecimalSep, $sThousandsSep, $sCurrencySymbol);

</actinic:block>

Automatically Rescale Your Images to a Certain Size

This is a handy PHP expression that will dynamically rescale your product images and display them in their new size. This resizing happens on the desktop PC, and the new files will be uploaded to the store with the other image files. The names of the new image files will all start with 't_'.

In order for it to work, your current images must be in *.jpg format and they must be saved in your 'Site' folder (usually 'Site1').

In the 'Design' tab, click on a product image. You should be in a layout called 'Standard Product Image'.

Replace the entire contents of the layout with the following:

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsPopUpDisplayedByImage%22%20%2f%3e">

   <actinic:block if="%3cactinic%3avariable%20name%3d%22ExtendedInformationType%22%20%2f%3e%20%3d%3d%20%22Opens%20in%20a%20Pop%2dUp%20Window%22">

      <a href="javascript:ShowPopUp('<actinic:variable name=ExtendedInfoPageEncoded />',<actinic:variable name="ExtInfoWindowWidth" />,<actinic:variable name="ExtInfoWindowHeight" />);">

   </actinic:block>

   <actinic:block if="%3cactinic%3avariable%20name%3d%22ExtendedInformationType%22%20%2f%3e%20%3d%3d%20%22Opens%20in%20the%20Same%20Window%22" >

      <a href="<actinic:variable name="ExtendedInfoPageName" />">

   </actinic:block>

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsProductImageDisplayed%22%20%2f%3e">

<actinic:block php="true" >

   // START Create a thumbnail image t_ProductImageFileName

 
$sOriginalImageName = '<actinic:variable  encoding="perl" name="ProductImageFileName"  selectable="false" />';


$sThumbImageName = 't_' . $sOriginalImageName;


$image = @imagecreatefromjpeg($sOriginalImageName); /* Attempt to open */

    
if (!$image) 




{ /* See if it failed */




echo "<br><font color=red>Thumbnail creation error opening: $sOriginalImageName </font>";




}



else




{




// Get new dimensions




$width = imagesx($image);




$height = imagesy($image);




$t_width = 100;




$t_height = $height * ($t_width / $width);




// Resample




$thumbimage = imagecreatetruecolor($t_width, $t_height);




imagecopyresampled($thumbimage, $image, 0, 0, 0, 0, $t_width, $t_height, $width, $height);




if ( ! imagejpeg($thumbimage, $sThumbImageName) ) 





{





echo "<font color=red>Thumbnail image creation failed: $sThumbImageName </font><br>";





}




else





{





echo "<br><img src=\"$sThumbImageName\" width=\"$t_width\" height=\"$t_height\" />";





}





}

 // END Create a thumbnail image t_ProductImageFileName

 </actinic:block>  

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsProductImageDisplayed%22%20%2f%3e%20%3d%3d%20False">

   <img src="<actinic:variable name="DefaultProductImage" />"

      border="0"

      alt="<actinic:variable name="ProductName" />" />

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsPopUpDisplayedByImage%22%20%2f%3e">

   </a>

</actinic:block>
To use a different width, change the value in this line to a larger/smaller value:

$t_width = 100;
You can now use the following line to include the rescaled product images elsewhere in your product layout, or in the best seller/new products/related items/also bought lists:

<img src="t_<actinic:variable name="ProductImageFileName" />" />

With grateful thanks to Norman Rouxel (http://www.drillpine.biz/) for this solution.

Showing Choices as Out of Stock

With version 8, you have the ability to list the permutations of a product (from the 'Permutations' tab of a component) within a drop-down list. To lay out permutations in a drop down list, go to the 'Layout' tab of a component and select the 'Component With Selectable Permutations' layout choice.
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As you are probably aware, it is possible to associate permutations with products in the store. This technique will automatically change a permutation from the list if the associated product goes out of stock.

There are two ways this can be shown in the online store: 

· Remove the item from the list.
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· Show the option but put 'Out of Stock' after it.
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This exercise will show both methods, and will use the 'Starter Computer Bundle' product in the default store as an example.

The first thing you need to do is set up stock monitoring on your associated products in the store. In the case of the 'Starter Computer Bundle' these are the three hidden products in the 'Computers' section – '17 inch Monitor', '19 inch Monitor' and '21 inch monitor'.

1. Go to the associated products in your store and go to the 'Stock' tab.

2. For each associated product, select the 'Stock Monitoring' checkbox and enter a stock level in.

You are now going to create a new re-usable condition that will check whether a permutation is in stock or not.

3. Go to 'Design | Library | Conditions'.

4. Right-click on the 'Permutations' group and select 'New Condition'.

5. Give it a name of IsAssociatedProductInStock and enter a description and a prompt (these can be anything).

6. Set the value of the condition to:
((<actinic:variable name="AssociatedProduct::IsStockMonitored" /> == false) OR
(<actinic:variable name="AssociatedProduct::StockLevel" /> > <actinic:variable name="AssociatedProduct::StockSuspendLevel" />))
You can just copy and paste the above into the 'Condition' field to create the condition.
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7. Click 'OK' and close the library

To make the out of stock option disappear:

8. Go to the 'Design' tab, select the 'Starter Computer Bundle' product and click on the 'Monitor' permutation drop-down list.
9. The layout code window should now contain the layout called 'Drop Down Permutation List'. It should contain a layout selector called Drop Down Permutation Entry
10. Highlight this layout selector and click the 'Insert Block' button (green 'C' with a '+')

11. Copy and paste the following expression into the condition editor:

(<actinic:variable name="PermutationAssociatedNameIsUsed" /> == FALSE) OR (<actinic:variable name="PermutationAssociatedNameIsUsed" /> AND <actinic:variable name="IsAssociatedProductInStock" /> == TRUE)
12. Click on 'Apply'

You can now test this by putting one of the associated products out of stock. The row in the list should disappear.

To add an 'Out of Stock' note to the end of the item.
13. Go to the 'Design' tab, select the 'Starter Computer Bundle' product and click on the 'Monitor' permutation drop-down list.

14. The layout code window should now contain the layout called 'Drop Down Permutation List. It should contain a layout selector called Drop Down Permutation Entry
15. Right-click on the layout selector and select 'Navigate To'. You should now be in a layout called 'Drop Down Permutation Entry'.

16. Locate the line that contains PermutationPrice – this should be line 9.

17. Underneath this, create a blank line and copy and paste in the following code:

<actinic:block if="%3cactinic%3avariable%20name%3d%22PermutationAssociatedNameIsUsed%22%20%2f%3e%20AND%20%3cactinic%3avariable%20name%3d%22IsAssociatedProductInStock%22%20%2f%3e%20%3d%3d%20false"> OUT OF STOCK</actinic:block>
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18. Now click 'Apply'. The 'OUT OF STOCK' text should appear next to any products that are out of stock.
Laying Out Your Permutations as Radio Buttons
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If you are using components with attributes and choices, it is possible to include the permutation prices (and associated product names) in the drop down list of choices by selecting a 'Component Layout' of 'Component Layout With Selectable Permutations'.

By default, this is just a drop down list. If you want your permutations to appear as radio buttons then do the following:

1. Go to 'Design | Library | Layouts' and expand the 'Components' group.

2. Right-click on any layout within that group and select 'New Layout'.

3. Call the new layout 'Permutations As Radio Buttons' and click 'OK'.

4. Now double-click on that layout and replace all the code there with the following HTML:

<actinic:block if="%3cactinic%3avariable%20name%3d%22ComponentDisplayLabel%22%20%2f%3e%20%21%3d%20%22%22">


<br />

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsComponentCheckboxShown%22%20%2f%3e">

   <input type="checkbox" name="<Actinic:Variable Name="UIWidgetName"/>" <actinic:block if="%3cactinic%3avariable%20name%3d%22IsSelectedByDefault%22%20%2f%3e">checked="checked"</actinic:block> />

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsComponentHiddenFieldIncluded%22%20%2f%3e">

   <input type="hidden" name="<Actinic:Variable Name="UIWidgetName"/>" value="on" />

</actinic:block>

<Actinic:Variable Name="ComponentDisplayLabel" />

<br />

<actinic:block if="%3cactinic%3avariable%20name%3d%22ComponentIsOptional%22%20%2f%3e%20AND%20%3cactinic%3avariable%20name%3d%22IsUsedNoneChoiceLabel%22%20%2f%3e%20AND%20%21%3cactinic%3avariable%20name%3d%22IsSelectedByDefault%22%20%2f%3e" >

<input type="radio" checked="checked" name="<actinic:variable name="PermutationAttributeList" value="Attribute IDs" />" value="-1" /> <actinic:variable name="NoneChoiceLabel" /> <br />

</actinic:block>

<actinic:block type="PermutationList" >

<actinic:block if="%3cactinic%3avariable%20name%3d%22PermutationIsValid%22%20%2f%3e">

<input type="radio" <actinic:block if="%28%3cactinic%3avariable%20name%3d%22ListIndex%22%20%2f%3e%20%3d%3d%201%29%20AND%20%28%3cactinic%3avariable%20name%3d%22IsUsedNoneChoiceLabel%22%20%2f%3e%20%3d%3d%20false%29" >checked="checked"</actinic:block> name="<actinic:variable name="PermutationAttributeList" value="Attribute IDs" />" value="<actinic:variable name="PermutationChoiceList" value="Permutation Choice ID List" />" />

   <actinic:block if="%3cactinic%3avariable%20name%3d%22PermutationAssociatedNameIsUsed%22%20%2f%3e%20%3d%3d%20FALSE">


   <actinic:variable name="PermutationChoiceList" value="Permutation Choice Name List" />

   </actinic:block>

   <actinic:block if="%3cactinic%3avariable%20name%3d%22PermutationAssociatedNameIsUsed%22%20%2f%3e">

      <actinic:variable name="AssociatedProduct::ProductName" />

   </actinic:block>

   <actinic:variable name="PermutationPrice" />

   <br />

</actinic:block>

</actinic:block>

5. Then save the layout by clicking 'OK' and close the library.

You will be able to select your new layout within the 'Component Layout' drop down list within the 'Layout' tab of your components.

Inserting Your Own Custom Rollover Buttons

To insert your own custom navigation buttons, with image rollovers, you can recycle the code from any of the existing navigation image layouts.

1. Go to 'Design | Library | Layouts'.

2. Locate the 'Navigation Icons' group and click on any layout in the list whose name ends in 'Image Navigation Button'.
3. Right-click on this layout and select 'New Layout'. Call your new layout whatever you want.

4. Customise the code as you see fit.

Image navigation button layouts have the following format:

<a href="http://url.to.link.to/" target="_self" onmouseover="SwapImage('image_name','rollover_image.gif')" onmouseout="RestoreImage()"><img src="normal_image.gif" alt="Some alternative text" border="0" name="image_name" /></a>

Substitute the placeholder values in there with real relevant values for you.

· normal_image.gif - the normal button graphic

· rollover_image.gif - the highlighted button graphic

· image_name - a name for the image. Each button needs to have a unique name.

Creating a Rollover for your Section Links

To do this exercise, you are going to create a new user-definable variable for the rollover image, and then include this variable into the section link layout you are using.

1. First of all, go to 'Design | Library | Variables', right-click on the 'Section' variable group and create a new user definable variable called and 'SectionImageAlt'.

2. Give it a prompt of 'Alternative Section Image', set the 'Place of Setting' to be 'Section' and make sure 'Type' is set to 'Filename'. Also, select 'Allow Empty Value' and de-select 'Allow <Use Parent> as an Option'.
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You can now edit the section link layout you are using to include your new variable.

3. Go to the 'Design' tab and click on a section link.

You should have selected a layout called something like 'Image on Left Section Link' or 'CSS Section Link Layout'.

4. Locate the following line:

[image: image77.png]<img alt="SectionName"” src="SectionImageFileName" border="0" />




This is the current image code. You are going to put a condition around this line so it only appears if there is no alternative section image.

5. Highlight this line and click the 'Insert Block' button - [image: image78.bmp]
6. Enter a condition that reads: SectionImageAlt == ""
(i.e. 'only show this code if SectionImageAlt is empty').

7. Click 'OK'.

8. You can now type your code for the image with the rollover. This should look like:

<img src="SectionImageFileName" alt="SectionName" onMouseOver="src='SectionImageAlt' " onMouseOut="src='SectionImageFileName' " border="0"> 

9. Finally, you need to highlight this new code and click the 'Insert Block' button. 
10. Insert a condition that says: SectionImageAlt != ""
(i.e. 'Only show this code if SectionImageAlt is not empty').

11. Click 'OK'.

Alternatively, simply replace the following tag:

[image: image79.png]<img alt="SectionName"” src="SectionImageFileName" border="0" />




...with the following code:

<actinic:block if="%3cactinic%3avariable%20name%3d%22SectionImageAlt%22%20%2f%3e%20%3d%3d%20%22%22">


<img alt="<actinic:variable name="SectionName"/>" src="<actinic:variable Name="SectionImageFileName"/>" border="0" />

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22SectionImageAlt%22%20%2f%3e%20%21%3d%20%22%22">


<img src="<actinic:variable name="SectionImageFileName" />" alt="<actinic:variable name="SectionName" />" onMouseOver="src='<actinic:variable name="SectionImageAlt" />' " onMouseOut="src='<actinic:variable name="SectionImageFileName" />' " border="0"> 

</actinic:block>

Now try entering an image filename into the 'Alternative Section Image' field in the 'Properties' tab. You should find that the section image changes when you move your mouse over it. 
Creating a Rollover for your Add to Cart Button

This exercise will create a new user-definable variable called 'AltCartButtonImage' and a new layout for the 'add to cart button', which includes rollover code.

1. Go to 'Design | Library | Variables' and right-click on the 'Product' group. Select 'New Variable'.

2. Give the variable a name of 'AltCartButtonImage' and enter a prompt of 'Alternative Cart Button Image'.
3. Set 'Place of Setting' as 'Site' and set the 'Tab Name' as 'General'.

4. De-select the 'Allow <Use Parent> as an Option' checkbox and under 'Type' select 'Filename'. Select the 'Allow Empty Values' checkbox.
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5. Click 'OK' and switch to the 'Layouts' tab of the library.

6. Locate the 'Add to Cart Button' group at the top of the library.

7. Right-click on 'Add To Cart Button Image' layout and select 'New Layout'.

8. Call it 'Rollover Add To Cart Button' and click 'OK'.

9. Now edit the code of the layout, and change it to look like the following:
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Here's some code to copy and paste: 

<input type="image" 

   src="<actinic:variable name="CartButtonImage" />"

   name="_<actinic:variable name="ProductReference" />" 

   alt="Add to Cart"

   onMouseOver="src='<actinic:variable name="AltCartButtonImage" />' "

   onMouseOut="src='<actinic:variable name="CartButtonImage" />' "

   />
10. Click 'OK' and then close the library.

You can now go to 'Settings | Site Options | General' and enter a filename for 'Alternative Cart Button Image'. Then all you need to do is change the 'Add To Cart Button Layout' to 'Rollover Add To Cart Button' and you will have a working cart button with rollovers.
Using The Same Layouts for Brochure Pages as for Section Pages

Doing this change means that the 'Overall Page Layout' field (which is controlled by a layout selector called 'StandardLayout') can be used for brochure pages as well as section pages. In other words, the default 'Overall Page Layout' you set in 'Settings | Site Options | Layout' will also be used for brochure pages.

1. Go to 'Design | Themes' and click the 'Advanced Themes Configuration' button

2. Change to the 'Page Layouts' tab and click the 'Advanced Page Configuration' button.

3. In the 'Brochure' row, change the 'Outer Layout Selector' from 'BrochureLayout' to 'StandardLayout'.

4. Click 'OK'.

In order to be able to overwrite this choice for different brochure pages, go to 'Design | Library | Layouts' and open the 'Web Page Outer Layout' group. Double-click on the 'StandardLayout' layout selector and under 'Place Of Setting' select 'Brochure'.

You can now set the 'Overall Page Layout' for your brochure pages.

How to Only Show Certain Sections in the Top Level Section List 

This will show you how to manually select which sections will appear in the 'top level section list' that is in the sidebar of most of the Actinic designs.

1. Go to 'Design | Library' and go to the 'Variables' tab.

2. Right click on the 'Section' group and select 'New Variable'
3. Give the variable a name of 'ShowInSidebar'.

4. Give it a prompt of 'Show Section in Sidebar'.

5. Under 'Place of Setting' select 'Section'.

6. Under 'Tab Name' select 'General'.

7. De-select 'Allow <Use parent> as an Option'
8. Change the 'Type' field to 'True/False'.

9. Leave the 'Top Level Value' and 'Initial Value' to 'True' if you want all sections shown by default. Set them both to 'False' if you don't.
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10. Click 'OK' and close the library.

11. Go to the 'Design' tab and in the preview pane click on one of the sections in your top level section list. You should now be looking at a layout called 'Section Name Only Section Link'.

12. Double click on the block if at the top of the layout code.
13. You should now be in the Condition Editor. Change the condition to:

<actinic:variable name="IsSectionIncludedInSiteMap" /> AND <actinic:variable name="ShowInSidebar" />
You can just copy and paste the code straight into the editor.
14. Click 'OK' and then click 'Apply' to confirm your changes. 

You can now go into the 'General' tab of any section that you don't want in the top level section list in the sidebar, and change 'Show Section In Sidebar' to 'False'.
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Creating Links to 'Previous' and 'Next' Sections

Actinic allows you to include links to 'previous' and 'next' sections (i.e. sections at the same level in the store – sometimes known as 'sibling sections'). 

To include a link to the previous section, insert the layout selector called 'PrevNextSectionLink' and use a fixed layout of 'Link To Previous Section'. For the link to the next section, the fixed layout you want to use is 'Link To Next Section'.
The following screenshot shows some example code to do this:
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Here is some code to copy and paste:
<div style="float: left;">

   <actinic:variable name="PrevNextSectionLink" value="Link to Previous Section" />

</div>

<div style="float: right;">

   <actinic:variable name="PrevNextSectionLink" value="Link to Next Section" />

</div>

Including Brochure Pages in the Site Map

This technique will show you how to include a list of the brochure pages in your store into your site map page.

The first thing you need to do is create a brochure page link layout that is similar in style to the existing links in the site map.

1. Go to 'Design | Library | Layouts' and expand the 'Brochure Page Links' group.

2. Right-click on 'Text Brochure Page Link' and select 'New Layout'. 

3. Give it a name of 'Sitemap Brochure Page Link' and click 'OK'.

4. Double-click on this layout and replace everything in it with the following code:

<a href="<actinic:variable name="BrochurePageURL" />">- <actinic:variable name="BrochureName" /></a>
5. Click 'OK'.

Next you need to create a brochure page list layout to be inserted in the site map page.

6. In the library, open the 'Brochure Page Link Lists' group.

7. Right-click on 'Brochure Page Text Link List' and select 'New Layout'.

8. Give it a name of 'Sitemap Brochure Page List' and click 'OK'.
9. Double-click on this new list layout to edit it.

10. Right-click on the layout selector that is there already and select 'Edit Appearance'.
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11. Change the 'Use Fixed Layout' field to read 'Sitemap Brochure Page Link' and click 'OK'.
12. Click the 'Edit List Layout Settings' button.

13. Change to the 'Edit Rows and Columns' tab and replace each instance of '&nbsp;' in the grid with '<br />'.
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14. Click 'OK' and then click 'OK' again to close the layout.

15. Exit the Library.

You can now include this new list in the 'Sitemap Page Bulk Area' layout.

16. In the 'Design' tab, use the 'Select Page Type' list to change the page to 'Site Map'.

17. Click on one of the site map links in the preview.

18. Click the 'Navigate to Parent Layout' button - [image: image87.bmp] - until you are in the  'Sitemap Page Bulk Area' layout.

19. Put your cursor in line 2 and click the 'Insert Layout' button - [image: image88.bmp]
20. Insert the 'BrochurePageList' layout selector with a fixed layout of 'Sitemap Brochure Page List'.

21. Click 'Apply'.

Your brochure pages will now be listed in the sitemap.
Hiding Top Level Section Links from the Sitemap

This exercise will show you how to prevent any links to top level sections from appearing in the Site Map.

First of all you need to get into the layout called 'Site Map Section List'.

You can either do this by going into 'Design | Library' – you will find it in the group called 'Site Map Section Lists' - or change the 'Select Page Type' drop down list in the 'Design' tab to 'Site Map'. Then click on one of the links in the sitemap and click the 'Navigate to Parent Layout' button  - [image: image89.bmp] - a couple of times.

Highlight the 'Site Map Section Link' layout selector and click the 'Insert Block' button - [image: image90.bmp]. The condition you want is:

<actinic:variable name="SectionLevel" /> > 2
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Click 'OK' to implement the rule.

The top level section links will now be hidden from the sitemap.

Advanced v8 List Functionality

A standard list of items in Actinic is created by inserting a 'list' layout into the design, and then inserting a layout within the list.

Here are some examples of how this appears in the Design Tree:
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It is also possible within Actinic to insert layout code that you want listed, directly into a layout, and then insert 'block' tags around this layout code to 'list' it - i.e. repeat the code however many times is necessary.

Here's an example. 

In the chapter called 'Including Brochure Pages in the Site Map' (earlier) you are shown how to insert a list of brochure pages into the site map bulk area. To do this, you had to create a new brochure link layout, then create a new brochure page list layout, and then insert them both into the design.

With these advanced list layouts, however, that is not necessary. All you need to insert into the 'Sitemap Page Bulk Area' layout is the following code:

<actinic:block type="BrochurePagesList">


<a href="<actinic:variable name="BrochurePageURL" />"><actinic:variable name="BrochureName" /></a>


<br />

</actinic:block>

This will include a basic list of brochure pages into the sitemap. 

As a further example, this code will give you a list of all the sections in your store:

<actinic:block type="EntireSectionList">

<a href="<actinic:variable Name="SectionPageName"/>">

   <actinic:variable Name="SectionName"/>

</a>

<br />

</actinic:block>

The crucial element in the <actinic:block> tag is the type= value. This tells Actinic what type of list to draw.

The full list of 'list types' is as follows:

· BrochurePagesList – lists all the brochure pages in the store

· BrochureFragmentsList – lists all the fragments in the current brochure page

· EntireSectionList – lists all the sections in the store

· TopLevelSectionList – lists the top level sections in the store

· ChildSectionList – lists all the sub sections within the current section

· ParentSectionList – lists all the sections above the current section

· ProductList – lists all the products within the current section

· PriceList – lists all the prices for the product (when using quantity-dependent pricing)

· ComponentList – lists all the components within the current product

· AttributeList – lists all the attributes within the current product/component

· ChoiceList – lists all the choices within the current attribute

· PermutationList – lists all the permutations within the current component

· PermutationChoiceList – lists all the choices that make up the current permutation

· DayList – all the days that can be selected for a date info prompt

· MonthList – all the months that can be selected for a date info prompt

· YearList – all the years that can be selected for a date info prompt

· ProductDiscountList – lists all the discounts for the current product

· SectionDiscountsList – lists all the discounts for the current section

· BestSellersList – lists all the best sellers in the store

· NewProductsList – lists all the new products in the store

· AlsoBoughtList – lists all the 'also bought' items for the current product

· RelatedProductsList – lists all the related items for the current product

· SearchPriceBandList – lists all the price bands on a search page

· SearchPropertiesList – lists all the searchable property fields on a search page

· SearchPropertyValueList – lists all the values within a searchable property field

· CountryList – lists all the countries to choose from in the checkout

· StateList – lists all the states to choose from in the checkout

· CreditCardTypeList – lists all the different types of credit card to choose from

You can also use lists within lists, e.g. the following code will give you a basic product list containing a list of component names and a list of attribute names:

<actinic:block type="ProductList" />


<b><actinic:variable name="ProductName" /></b> <br/>


<actinic:block type="ComponentList" />



&nbsp;<actinic:variable name="ComponentName" /> <br/>



<actinic:block type="AttributeList" />




&nbsp;&nbsp;<actinic:variable name="AttributeName" /> 


<br/>



</actinic:block>


</actinic:block>

</actinic:block>

Section List With Sub Sections In Bullets

This code can be used on any page, and will give a list of the main sections, and any sub-sections will be listed in a bulleted list underneath the main section heading.

<actinic:block type="EntireSectionList">

<actinic:block if="%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3d%3d%201" >


<br /><strong><a href="<actinic:variable name="SectionPageName"/>" target="_self"><actinic:variable name='SectionName'/></a></strong>

</actinic:block>

<actinic:block if="%28%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3d%3d%202%29%20AND%20%28%3cactinic%3avariable%20name%3d%22ListIndex%22%20%2f%3e%20%3d%3d%201%29" >


<ul>

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3d%3d%202">


<li><a href="<actinic:variable name="SectionPageName"/>" target="_self"><actinic:variable name='SectionName'/></a></li>

</actinic:block>

<actinic:block if="%28%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3d%3d%202%29%20AND%20%28%3cactinic%3avariable%20name%3d%22ListIndex%22%20%2f%3e%20%3d%3d%20%3cactinic%3avariable%20name%3d%22ListCount%22%20%2f%3e%29" >


</ul>

</actinic:block>

</actinic:block>

Including Section Lists with Javascript

Actinic has the ability to generate a JavaScript array file (with an extension of *.js) that contains information about all the top-level sections, or the entire section tree complete with sub-sections. This section information is in the form of 'array' data. This file is uploaded with the store pages, and can be used to generate drop-down lists, list boxes and other more advanced navigation tools to help your customers to jump to their desired sections of the store. The advantage of using this external file is that it can be used by web pages that are located outside the store, so that a list of all the store sections can be incorporated into any web page. This list will be automatically updated by Actinic as you make changes to the structure of the online store.

The list of all the layouts available to perform this function, with a description of what they do, the JavaScript file they cause to generate and the HTML they include in the page, is below. You will find all the layouts within the 'JavaScript Section List' group in the library, and they are all inserted into the design via the 'JavaScriptArray' layout selector.
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There are some examples of how to incorporate this code at the bottom of this section.

	Layout:
	All Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections.js that contains all the names, URLs, image filenames, image heights and widths and section IDs* of the top-level sections of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections.js"></script>


	Layout:
	All Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree.js that contains all the names, URLs, image filenames, image heights and widths and section IDs* for every section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree.js"></script>


	Layout:
	Name Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_names.js that contains all the names for every section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_names.js"></script>


	Layout:
	URL Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_URLs.js that contains all the URLs for every section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_URLs.js"></script>


	Layout:
	Image Name Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_images.js that contains all the image filenames for every section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_images.js"></script>


	Layout:
	Image Width Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_imagewidths.js that contains all the image widths for every section image in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_imagewidths.js"></script>


	Layout:
	Image Height Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_imageheights.js that contains all the image heights for every section image in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_imageheights.js"></script>


	Layout:

	ID Data From All Sections

	Description:
	Will cause the generation of a JavaScript file called Act_section_tree_ids.js that contains all the section IDs* for every top-level section in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_section_tree_ids.js"></script>


	Layout:

	Name Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_names.js that contains all the names for every top-level section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_names.js"></script>


	Layout:

	URL Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_URLs.js that contains all the URLs for every top-level section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_URLs.js"></script>


	Layout:

	Image Name Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_images.js that contains all the image filenames for every top-level section of the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_images.js"></script>


	Layout:

	Image Width Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_imagewidths.js that contains all the image widths for every top-level section image in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_imagewidths.js"></script>


	Layout:

	Image Height Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_imageheights.js that contains all the image heights for every top-level section image in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_imageheights.js"></script>


	Layout:

	ID Data From Top Level Sections

	Description:
	Will cause the generation of a JavaScript file called Act_sections_ids.js that contains all the section IDs* for every top-level section in the online store. Also creates the HTML in the store to incorporate that file.

	Code inserted into design:
	<script type="text/javascript" src="Act_sections_ids.js"></script>


There is also a layout type group called 'JavaScript Sub Section Lists' which contains the following layouts:

· List Of All Data From Sub Sections

· List Of Name Data From Sub Sections

· List Of URL Data From Sub Sections

· List Of Image Name Data From Sub Sections

· List Of Image Width Data From Sub Sections

· List Of Image Height Data From Sub Sections

· List Of ID Data From Sub Sections

They are all inserted into the design via the 'JavaScriptSubSectionArray' layout selector.

These perform the same function as the layouts already described (creating a JavaScript array containing the section details) but these insert the information about the sub-sections within the current section. In other words, the section information they contain will depend on what section page they are being used within. These placeholders work differently as they will actually embed the JavaScript array into the page when the pages are generated. They do not cause the creation of an external JavaScript file. 

* A section ID is a unique number associated with every section in the online store. They are used by forms to allow customers to jump to particular sections in the online store. 

Note About Inserting Jump Lists In The Main Product Area

If you are including any of the 'jump lists' below within the main product area of a page, you will need to precede the code with the following line:

</form>

and then copy and paste the following lines after the form code:

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsMainFormUsed%22%20%2f%3e">

      <form method="post" action="<actinic:variable name="OnlineScriptURL" value="Shopping Cart Script URL" />"> 

         <input type="hidden" name="SID" value="<Actinic:Variable Name="SectionID"/>" />

         <input type="hidden" name="PAGE" value="PRODUCT" />           

         <input type="hidden" name="PAGEFILENAME" value="<actinic:variable name="SectionPageName" />" />

         <Actinic:SECTION blob='<Actinic:Variable Name="SectionCatFile"/>'/>

         <input type="hidden" name="RANDOM" value="<actinic:variable name="Random" />" />

         <actinic:block if="%3cactinic%3avariable%20name%3d%22IsHostMode%22%20%2f%3e">

            <!-- Hidden field when in trial mode -->

            <input type="hidden" name="SHOP" value="<Actinic:Variable Name="HiddenFields"/>" />

         </actinic:block>

</actinic:block>

This is to ensure the continuation of the main store page form either side of the jump list.

Creating a Jump List Containing the Top-Level Sections

This exercise will insert a drop-down list containing a list of top-level sections into the HTML of your store. As soon as a customer selects a section, they will jump to it.

When presented to customers in the browser, the code becomes a drop-down list containing a list of the top-level sections.  
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To include this, paste the following just above the </head> tag of your overall page layout:

<actinic:variable name="JavaScriptArray" value="All Data From Top Level Sections" />
<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">

<!--

/***********************************************************************

*

* ACT_DropListBox -
returns a string containing the HTML for the SELECT listbox

*

************************************************************************/

function ACT_DropListBox(ar)


{


var strIDs = '<SELECT SIZE="1" NAME="ACT_droplstbox" onClick="if(options[selectedIndex].value) window.location.href=(options[selectedIndex].value)">'

  
var sel = " SELECTED"

  
strIDs += '<OPTION ' + sel + ' VALUE="">Select a Section</OPTION>'

  
for (var i=1;i<=ar.length;i++)

  

{



if (ar[i].sURL !=null)




{




strIDs += '<OPTION VALUE="' + ar[i].sURL + '">' + ar[i].sName + '</OPTION>'




}

  

}


strIDs+='</SELECT>'

  
return strIDs

  
}

//-->

</SCRIPT>
Paste the following code within your store design where you want the drop-down list to appear.

<form name="Act_SectionDroplist">

        <script language=Javascript1.1>document.write(ACT_DropListBox(sections))</script>

</form>

Creating a Drop-Down List Containing the Top-Level Sections and Sub Sections

This exercise will insert a drop-down list containing a list of sections and subsections (to three levels of depth) into the HTML of your store. As soon as a customer selects a section, they will jump to it.

Paste the following code just above the </head> tag in your overall page layout:

<actinic:variable value="All Data From All Sections" name="JavaScriptArray" />

<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">

<!--

/***********************************************************************

*

* ACT_DropListBox -
returns a string containing the HTML for the SELECT listbox

*

************************************************************************/

function ACT_DropListBox(ar)

{

var strIDs = '<SELECT SIZE="1" NAME="ACT_droplstbox" onClick="if(options[selectedIndex].value) window.location.href=(options[selectedIndex].value)">';

var sel = " SELECTED"

strIDs += '<OPTION ' + sel + ' VALUE="">Select a Section</OPTION>';

for (var i=1;i<=ar.length;i++)

  {

  if (ar[i].sURL !=null)

    {

    strIDs += '<OPTION VALUE="' + ar[i].sURL + '">' + ar[i].sName + '</OPTION>';

      {

      if (ar[i].pChild)

        {

        for (var j=1;j<=ar[i].pChild.length;j++)

          {

          strIDs += '<OPTION VALUE="' + ar[i].pChild[j].sURL + '">' + '- ' + ar[i].pChild[j].sName + '</OPTION>';

            {

            if (ar[i].pChild[j].pChild)

              {

              for (var k=1;k<=ar[i].pChild[j].pChild.length;k++)

                {

                strIDs += '<OPTION VALUE="' + ar[i].pChild[j].pChild[k].sURL + '">' + '- - ' + ar[i].pChild[j].pChild[k].sName + '</OPTION>';

                }

              }

            }

          }

        }

      }

    }

  }

strIDs+='</SELECT>'

return strIDs

}

//-->

</SCRIPT>

Then paste the following code where you want the drop-down list to appear.

<form name="Act_SectionDroplist">

        <script language=Javascript1.1>document.write(ACT_DropListBox(section_tree))</script>

</form>
Creating a List Box Containing the Top-Level Sections

This exercise will insert a list box containing a list of top-level sections into the HTML of your store. As soon as a customer selects a section, they will jump to it.

It will look like the following:
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Place the following function just above the </head> tag in your overall page layout..

<actinic:variable name="JavaScriptArray" value="All Data From Top Level Sections" />
<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">

<!--

//ACT_ListBox(ar) 

//ar= Section array name, returns a string containing the HTML for the SELECT listbox.

function ACT_ListBox(ar)

  {

  var strIDs = '<SELECT SIZE="' + ar.length + '" NAME="ACT_lstbox" onClick="if(options[selectedIndex].value) window.location.href=(options[selectedIndex].value)">' 

  var sel = ' SELECTED'

  for (var i=1;i<=ar.length;i++)

    {

    strIDs += '<OPTION ' + sel + ' VALUE="' + ar[i].sURL + '">' + ar[i].sName + '</OPTION>'

    sel = ''

    } 

  strIDs+='</SELECT>'  

  return strIDs

}

//-->

</script>

And then the following code where you want the list box to appear:

<FORM>

<script language=Javascript1.2>


document.write(ACT_ListBox(sections) + "<BR>") 


</script>

</FORM>

Creating a Bulleted List containing the Top-Level Sections

This code will create a simple bulleted list containing the top-level sections in your store.

Paste the following code just above the </head> tag in your overall page layout.

<actinic:variable name="JavaScriptArray" value="All Data From Top Level Sections" />
<SCRIPT LANGUAGE = JavaScript>

<!--

function BulletList(pItem)

{

var strIDs = '<ul>';

  {

  for (var i = 1; i <= pItem.length; i++)

    {

    strIDs += '<li><a href=' + pItem[i].sURL + '>'+ pItem[i].sName + '</a></li>';

    }

  }

strIDs += '</UL>'

return strIDs

}

-->

</SCRIPT>

And then insert the following code in the main body of the page where you want the bulleted list to appear.

<script language=Javascript1.2>


document.write(BulletList(sections)) 

</script>

Creating a List of Hyperlinks with Sections and Sub-sections

This code will lay out your sections and sub-sections within a list of hyperlinks (first depth of sub-sections only). The sub-sections will appear indented.

Paste the following code just above the </head> tag in your overall page layout:

<actinic:variable value="All Data From All Sections" name="JavaScriptArray" />

<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">

<!--

function SectionList(ar)

{

var strIDs = '<table border=0 width=95% cols=2>';

for (var i=1;i<=ar.length;i++)

{

if (ar[i].sURL !=null)

{

strIDs += '<tr><td colspan=2><a href="' + ar[i].sURL + '"><span class="actxxsmall">' + ar[i].sName + '</span></a></td></tr>';

{

if (ar[i].pChild)

{

for (var j=1;j<=ar[i].pChild.length;j++)

{

if (j <= ar[i].pChild.length)

{

strIDs += '<tr><td><img src=shim.gif width=5></td><td><a href="' + ar[i].pChild[j].sURL + '"><span class="actxxsmall">' + ar[i].pChild[j].sName + '</span></a></td></tr>';

}

}

}

}

}

}

strIDs += '</table>' 

return strIDs

}

//-->

</SCRIPT>
And then insert the following code in the main body of the page where you want the list to appear.

<script language=Javascript1.1>document.write(SectionList(section_tree))

</script>

Creating a List of Hyperlinks with Sections and Two Levels of Sub-sections

This code will lay out your sections and two levels of sub-sections within a list of hyperlinks. The sub-sections will appear indented.

Paste the following code just above the </head> tag in your overall page layout:

 

<actinic:variable value="All Data From All Sections" name="JavaScriptArray" />

 

<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">
<!--
function SectionList(ar)
{
var strIDs = '<table border=0 width=95% cols=2>';
for (var i=1;i<=ar.length;i++)
  {
  if (ar[i].sURL !=null)
    {
    strIDs += '<table><tr><td colspan=2><a href="' + ar[i].sURL + '"><span class="actxxsmall">' + ar[i].sName +  '</span></a></td></tr></table>';
      {
      if (ar[i].pChild)
        {
        for (var j=1;j<=ar[i].pChild.length;j++)
          {
strIDs += '<table><tr><td><img src=shim.gif width=5></td><td><a href="' + ar[i].pChild[j].sURL + '"><span class="actxxsmall">' + ar[i].pChild[j].sName + '</span></a></td></tr></table>';          

 

            {
            if (ar[i].pChild[j].pChild)
              {
              for (var k=1;k<=ar[i].pChild[j].pChild.length;k++)
                {

 

  strIDs += '<table><tr><td width="20"></td><td><a href="' + ar[i].pChild[j].pChild[k].sURL + '"><span class="actxxsmall">' + ar[i].pChild[j].pChild[k].sName + '</span></a></td></tr></table>';

 

                }
              }
            }
          }
        }
      }
    }
  }
strIDs += '</table>' 
return strIDs
}
//-->
</SCRIPT>

 

and this bit to go into the main body:

 

<script language=Javascript1.1>document.write(SectionList(section_tree))
</script>
Creating a Section List (With Sub-Sections) in 2 Columns

This code will lay out your sections and two levels of sub-sections within a list of hyperlinks. The sub-sections will appear indented.

Paste the following code just above the </head> tag in your overall page layout:

<actinic:variable value="All Data From All Sections" name="JavaScriptArray" />

<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">
<!--
function SectionList(ar)
{
var col = 1;
var strIDs = '<table width="100%"><tr><td valign=top width="50%">';
for (var i=1;i<=ar.length;i++)
{
if (ar[i].sURL !=null)
{
strIDs += '<a href="' + ar[i].sURL + '"><span class="actxsmall">' + ar[i].sName + '</span></a><br>';
{
if (ar[i].pChild)
{
for (var j=1;j<=ar[i].pChild.length;j++)
{
if (j <= ar[i].pChild.length)
{
strIDs += '<a href="' + ar[i].pChild[j].sURL + '"><span class="actxxsmall">' + ar[i].pChild[j].sName + '</span></a><br>';
}
}
}
}
if ( col == 1 )
{
strIDs += '</td><td valign=top width="50%">';
col++;
}
else
{
strIDs += '</td></tr><tr><td valign=top width="50%">';
col = 1;
}
}
}
if ( col == 1 ) strIDs += '</td><td>';
return strIDs + '</td></tr></table>';
}
//-->
</SCRIPT>


and this bit to go into the main body:

<script language=Javascript1.1>document.write(SectionList(section_tree))
</script>

Listing Sub-Sections Within Each Main Section

This code will create a list of sections and sub-sections (first depth of sub-sections only) into your store in the following style:

First Section
Subsection 1, Subsection 2
Second Section
Sub section 1, Subsection 2, Subsection 3

Paste the following code just above the </head> tag in your overall page layout:

<actinic:variable value="All Data From All Sections" name="JavaScriptArray" />

<SCRIPT LANGUAGE="JavaScript" TYPE="text/javascript">

<!--

function YahooSections(ar)

{

var strIDs = '';

for (var i=1;i<=ar.length;i++)

  {

  if (ar[i].sURL !=null)

    {

    strIDs += '<a href="' + ar[i].sURL + '"><span class="actregular">' + ar[i].sName + '</span></a><br>';

      {

      if (ar[i].pChild)

        {

        for (var j=1;j<=ar[i].pChild.length;j++)

          {

          if (j < ar[i].pChild.length)

            {

            strIDs += '<a href="' + ar[i].pChild[j].sURL + '"><span class="actxsmall">' + ar[i].pChild[j].sName + '</span></a>, ';

            }

          else

            {

            strIDs += '<a href="' + ar[i].pChild[j].sURL + '"><span class="actxsmall">' + ar[i].pChild[j].sName + '</span></a>, ...';

            }

          }

        }

      }

    strIDs += '<br><br>'

    }

  }

return strIDs

}

//-->

</SCRIPT>

And then insert the following code in the main body of the page where you want the list to appear.

<script language=Javascript1.2>


document.write(YahooSections(section_tree)) 

</script>

Inserting a List of Section Images With JavaScript

This section will insert your top-level section images in a list, one underneath the other. When a customer clicks on a section image they will be taken into that section.

Paste the following code just above the </head> tag in your overall page layout:

<actinic:variable value="All Data From Top Level Sections" name="JavaScriptArray" />

<SCRIPT LANGUAGE = JavaScript>

<!--

function ImageList(pItem)

{

var strIDs = '';

  {

  for (var i = 1; i <= pItem.length; i++)

    {

    strIDs += '<a href=' + pItem[i].sURL + '><img src="' + pItem[i].sImage + '" alt="'+ pItem[i].sName + '" width=' + pItem[i].nImageWidth + ' height=' + pItem[i].nImageHeight + ' border=0></a><br>';

    }

  }

return strIDs

}

-->

</SCRIPT>

And then insert the following code in the main body of the page where you want the image list to appear.

<script language=Javascript1.2>


document.write(ImageList(sections)) 

</script>

Including an Actinic-Generated Drop-Down Anywhere on the Internet

Any of the preceding examples should work anywhere on the Internet, with the following conditions. 

Obviously the Actinic variables layouts will not be substituted on other pages, so you will need to include the fully generated call to the *.js file – including full path information. For example:

<script language="JavaScript" src="Act_section_tree.js"></script>

…will not work as it refers to a local file called 'Act_section_tree.js'. What will work are the following examples:

<script language="JavaScript src="../acatalog/Act_section_tree.js"></script>

or

<script language="JavaScript src="http://your.URL/acatalog/Act_section_tree.js"></script>

You also need to include the code contained within actiniccore.js and actinicextras.js. In other words, also include lines of the following form:

<script language="JavaScript" src="../acatalog/actiniccore.js"></script>

or

<script language="JavaScript" src="http://your.URL/acatalog/actiniccore.js"></script>

and 

<script language="JavaScript" src="../acatalog/actinicextras.js"></script>

or

<script language="JavaScript" src="http://your.URL/acatalog/actinicextras.js"></script>

These lines must be ABOVE any other script functions in the headers of your web site pages. 

Only Using a Single Parent Section List in a Design

By default, Actinic has two 'parent section lists' (breadcrumb trails) in the design – a top one and a bottom one. If you want to simplify this, and just have one parent section list, use the following steps.

1. Go to 'Design | Library | Layouts' and expand the 'Parent Section Lists' group.

2. Double-click on the 'ParentSectionListBottom' layout selector and de-select 'Site' under 'Place of Setting'.

3. Click 'OK' and close the library.

4. Now click on the 'bottom' parent section link in the preview in the 'Design' tab.

5. Click the 'Navigate To Parent Layout' button - [image: image98.bmp] - until you are in the 'Section Page' layout (called something like 'Standard Section Page' or 'Section Page With Section Name At The Top').

6. You can now delete the 'ParentSectionListBottom' layout selector. If you want, you can replace it with 'ParentSectionListTop'.

Having Different Background Colours on Different Pages

To have a different background colour on each page, you need to create a new user-definable variable called 'BackgroundColor' to replace the default 'BGColor' system variable.

1. To do this, first of all go into 'Design | Themes' and click 'Advanced Themes Configuration'.

2. Make a note of whatever you have set for the background colour at the moment.

3. Next, go to 'Design | Library | Variables', right-click on 'Appearance Settings' and select 'New Variable'.

4. Give it a name of 'BackgroundColor' and use a prompt of 'Background Color'. 

5. Under 'Place of Setting', select 'Site', 'Section' and 'Brochure' and set the 'Tab Name' to 'General'.

6. In 'Top Level Value', enter whatever you have got set as the background colour e.g. 'white' or '#ffffff'.
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7. Click 'OK' and close the library.

You now need to insert this variable into your overall page layouts for your sections and brochure pages.

8. View a section in the 'Design' tab.

9. Select the overall page layout for the page.

10. Locate the <body... > tag.

11. Add in the following line within the <body> tag:

style="background-color: <actinic:variable name="BackgroundColor" />;"
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You should now be able to change the background colour for each section by changing the 'Background Color' value in the 'General' tab of each section.

To apply this to brochure pages, just edit the overall page layout of a brochure page. 

Note: some themes use <div> tags to control the background colour of the main area of the page separately from the body background. For example, in the 'Executive' look out for this line:

<div class="page_body" align="center">
Add the style= command into this line to see the effect.

Have Every Navigation Button Appearing on Every Page

There are some rules on the default Actinic navigation bars to control which navigation button appears on which page. 

If you want to remove these rules, and have all buttons on all pages, then just go to 'Design | Library | Layouts' and expand the 'Navigation Bars' group.

Double-click on the navigation bar layout you want to edit.

Remove every green 'block' tag you see there EXCEPT the ones around the 'Up A Level' navigation icon.

You will now have every navigation button appearing on all pages.

Using the 'Thumbnail' Image in the 'Mini' Item Layouts

The items in the best sellers list, new products list, also bought list and related items list all have a 'Mini' item layout. This includes the name, price and description of the product, and also includes a small version of the product image.
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By default, the layout just uses the standard product image scaled down – but it is possible to use the image specified in the actual 'Thumbnail' product field instead.

To do this, click on the 'Mini' layout that you want to edit.

Locate the following code:
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Replace all three lines with the following:

<actinic:block if="%28%3cactinic%3avariable%20name%3d%22ProductImageFileName%22%20%2f%3e%20%21%3d%20%22%22%29%20AND%20%28%3cactinic%3avariable%20name%3d%22ProductThumbnailImageFileName%22%20%2f%3e%20%3d%3d%20%22%22%29" >

<img src="<actinic:variable name="ProductImageFileName" />" width="75" alt="<actinic:variable name="ProductName" />" />

</actinic:block>

<actinic:block if="%3cactinic%3avariable%20name%3d%22ProductThumbnailImageFileName%22%20%2f%3e%20%21%3d%20%22%22" >

<img src="<actinic:variable name="ProductThumbnailImageFileName" />" alt="<actinic:variable name="ProductName" />" />

</actinic:block>

Apply the changes to the layout.

The layout will now use the 'Thumbnail' image, if available.

Making The Best Seller/New Products Image Clickable

By default, the images that appear in the 'Mini Best Seller Layout' and the 'Mini New Product Layout' are not clickable. This is likely to be remedied in a later release of Actinic v8, but until then you can make the change yourself as follows.

Go to 'Design | Library | Layouts' and go to the 'Best Seller List Entries' group. Edit the layout called 'Mini Best Seller Layout'. 

Locate the line of code highlighted in the following image:
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Replace it with the following code:

<a href="<actinic:variable name="SearchCGIURL" />?PRODREF=<actinic:variable name="ProductReference" />&amp;NOLOGIN=1<actinic:block if="%3cactinic%3avariable%20name%3d%22IsHostMode%22%20%2f%3e">&amp;SHOP=<actinic:variable name="ShopID" /></actinic:block>">

   <img src="<actinic:variable name="ProductImageFileName" />" width="75" alt="<actinic:variable name="ProductName" />" />

</a>

You can also do the same to the 'Mini New Products Layout' located within the 'New Products List Entries' group in the 'Layouts' tab of the library.

Inserting Links to Save and Retrieve Shopping Carts

There are two variables available to include in your store designs, which will allow customers to save and retrieve their shopping carts whilst they are shopping.

The variable to save the current shopping cart is SaveCartUrl and the variable to restore a saved shopping cart is RestoreCartUrl.

You can include them in code such as:

<a href="<actinic:variable name="SaveCartUrl" />">Save Your Shopping Cart</a>
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<a href="<actinic:variable name="RestoreCartUrl" />">Restore A Saved Shopping Cart</a>
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Including Thumbnail Images in the Shopping Cart

It is possible to include the Actinic 'thumbnail images' ('Thumbnail Image' field in the 'General tab of your products) within the shopping cart next to the product name.

To do this, include the following code into the 'Cart Product Details' layout, which is in the 'Shopping Cart Product Details' group in 'Design | Library'.  Make sure it goes between <Actinic:XMLTEMPLATE NAME="ProductLine"> and its equivalent closing XML tag: </Actinic:XMLTEMPLATE>:

[image: image106.png]ProductNameOnline
ENOVE TAG="Inageline">

<img sro="Thunbrail" ThunbnailSize />
</Actinic:REMOVE>

<hetini





Here is some code to copy and paste:

<Actinic:REMOVE TAG="ImageLine">

   <img src="<actinic:variable name="Thumbnail" />" <actinic:variable name="ThumbnailSize" /> />

</Actinic:REMOVE>

Running Actinic within a Custom Frame

If you are just browsing products, then Actinic will run with no problems within an existing custom frame.

However, you must ensure that the frame set file is on the SAME domain (web site) as the Actinic store. If you do not do this then Internet Explorer will stop your Actinic store from working because it will treat the Actinic shopping cart cookie as a 'third party cookie' and customers will not be able to add products to their shopping cart.  The same will happen if you are accessing the store via a different URL than the one that is in your network settings.

Also, there are potential difficulties when you go get to the point of making payments in the checkout as no SSL padlock will appear within the browser if the secure pages are being viewed through a non-secure frame.
The best way to avoid this problem is to check where it says 'Remove Custom Frame in Checkout' in 'Design | Design Options'. This will mean that any frames will be removed at the start of the checkout phase.

In the 'URL for Completed and Aborted Checkout' field you can then put the URL for your frameset document. Therefore whenever anybody leaves the checkout for whatever reason, the frameset will be restored.

Adding New Terms and Conditions

If you leave any of the boxes in 'Business Settings | Terms and Conditions' empty then the corresponding heading (e.g. 'Remittance Terms') will not appear in the HTML.  However, if you wish to add your own Terms and Conditions entry you can fill in your text in an unused panel and then simply change the appearance of the title in the HTML. 

To do this, go to 'Design | Text' and search for the heading you want to change. 

Offering Payment Methods to Customers in Different Formats

In Actinic, you can access all the HTML used within the checkout. Most of it is accessible via the 'Design' tab (Checkout Page 0/1/2 and Receipt). However, some key elements are within 'Design | Text'. The most important of these is the drop-down list used to offer payment methods to your customers. 

To find the relevant section of Design | Text:

1. Go to 'Design | Text', click 'Go to' and go to prompt Phase: -1 and ID: 1951.

You will highlight the following section: 
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The highlighted line, and the three lines below it, contains the HTML used to build the payment-method drop-down list in the checkout. To change it to something else (in this case a list of radio buttons) you will need to do the following:

2. In the first line, delete <select name='PAYMENTMETHOD' size="1">

3. In the second line, replace <option value="%s">%s with

<input type="radio" name="PAYMENTMETHOD" value="%s">%s<br />
4. In the third line, delete </select>
5. In the fourth line replace <option selected="selected" value="%s">%s with

<input type="radio" name="PAYMENTMETHOD" value="%s" checked="checked">%s<br />

The finished result will look something like the following:
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Using a Text Field for Searchable Properties

Searchable properties allow you set up fields where customers can search on the values entered for the 'user-definable variables' in your store.
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Instructions for doing this are in the main help in 'Online Store Features | Searching On Product Properties'.

By default, searchable property values are shown as a list for customers to select from online. However, it is possible to amend this to be a free text input box where customers can enter the value they want to search on.

To do this, first you need to set up a working searchable property based on the Actinic default settings and upload this to your website. Use a 'HTML Representation' of 'Drop Down List'.
When you have done this, go to your search page online and view the source. Look for the HTML for the searchable property. It will look something like:

<select size="1" name="S&#95;Frame Colour0&#95;0">

...

</select>
Copy this code to the clipboard.

Now in Actinic edit the layout called 'Standard Searchable Property'. You can find this in 'Design | Library | Layouts' in the 'Searchable Properties' group.

Replace the 'SearchPropLayout' layout selector with the code copied from the generated page.
You now need to convert the code to a <input type="text" ...> field. In the case of the code above it would be:

<input type="text" name="S&#95;Frame Colour0&#95;0" value="" />

Then upload the store. The drop down list will now be replaced with a text field.

Including File Content Dynamically Online

If you want to include the content of a text file into your web pages, and the file only exists online (not on your PC) then use a link for the following form within your Actinic layouts:

<a rel="fragment" href="http://your.URL/name-of-file.html">Alternate text</a>

This will only work if the user has JavaScript enabled in their web browser. If they don't then the 'alternate text' will appear instead.
Section B:
Functionality Tips for Layouts
Creating PHP Functions

It is possible to include PHP expressions within the layouts in Actinic. These are only executed on the desktop, i.e. you cannot create PHP functions to dynamically change things online, but they still allow you to do a range of advanced customisations on your store data.
There are some example PHP functions elsewhere in this guide – to find them,  search this guide for: php="true"

To include a php expression into a layout, start the code with...

<actinic:block php="true">

...and finish it with...

</actinic:block>

When including a variable within a PHP function you need to right-click on it, select 'Edit Appearance' and then 'Encoding' to 'Quoted Perl' and set 'Selectable' to 'False'.

· encoding="perl" means that any line breaks, quotes etc. within the variable values that might break the PHP expression will be encoded safely.
· selectable="false" means that it cannot be selected in the 'Design' tab – this is essential as the dotted lines that get placed around selected variables will break PHP expressions.
Within the 'Actinic v8' folder there is a file called 'actinic_main.php' which contains a set of PHP functions that are referred to from within the Actinic default layouts. If you want to create your own php functions and then refer to them from your layouts, do the following:

1. Create a new file within the 'Actinic v8' folder called 'custom.php'.

2. Add your new functions within 'custom.php'

3. Place the following line within 'actinic_main.php':
include_once("custom.php");

Variable Qualifiers

A 'Variable Qualifier' is a way of specifying exactly where you want data to come from, where there is more than one choice for the data source.

There are three variable qualifiers:

· MainBrochure - used in brochure page links to insert details about the current brochure page.

· MainSection - used in section links to insert details about the current section.

· AssociatedProduct - used in permutation layouts to insert details about the associated product.

Here is the format of a variable qualifier:

<actinic:variable name="VariableQualifier::VariableName"/>

Here are some examples of where to use them.
If you insert the following variable within a brochure page link layout, it will insert the name of the current brochure page into the layout:
<actinic:variable name="MainBrochure::BrochureName" />

For example, if the list of brochure pages was displaying on a page called 'Home', the above variable would be substituted for the text 'Home'.

The following variable will insert the ID of the current section into the section list:

<actinic:variable name="MainSection::SectionID" />

So if the section list was displaying within a section that had an ID of '5', the above variable would be substituted for the number '5'.
Finally, you can enter almost any product variable into a permutation layout with the variable qualifier of 'AssociatedProduct' and the details of the associated product will be shown in the permutation layout. For example:
<actinic:variable name="AssociatedProduct::ProductName" />

... will insert the name of the associated product into the permutation layout.

Advanced Best Seller and New Products Lists

This exercise will show you how to generate best seller and new products lists in their own separate page and then include them in via a JavaScript 'include' command on the web site. This means that if you have 1,000 sections, and then the content of the best sellers list changes, you will not have to upload 1,000 changed pages the next time you upload.

This exercise will use best sellers list as the example, but it is simple enough to adapt this exercise for new products pages.

Please note that this function does not work with Netscape browsers.

The first thing you need to do is create a new layout type group in the library.

1. Go to 'Design | Library', right-click on any of the existing layout type groups and select 'New Layout Type'.

2. Give it a name of 'Page Snippets' and under 'Layouts' select 'Pop-Up'. Click 'OK'.
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3. Within this new layout type group, create a new layout and give it a name of  'Best Sellers Page Snippet'.

4. Now double-click on the layout to edit it.

5. In the layout code, click the 'Insert Layout' button and insert the layout selector called 'BestSellerListSidebar'. You can use a fixed layout (by selecting  'Use Fixed Layout') if you want to use a specific best sellers list layout.

If you are doing a new products list, then include the 'NewProductListSidebar' selector here.

6. Now click the 'Edit Layout Details' button.

7. Change the 'Extended Info Page File Name' field to read 'bs-snippet.html'.
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8. Click 'OK', 'OK' again to close the layout.

You now need to create a layout selector to insert this layout into the design.

9. Right-click on the 'Page Snippets' layout type group name, and select 'New Selector'.

10. Give it a name of 'BestSellersSnippet' and a prompt of 'Best Sellers Snippet'.

11. Change to the 'Values' tab.

12. Highlight 'Best Sellers Page Snippet' in the left column and click the '>' button to move it to the right column. 

13. Change back to the 'Basic Definition' tab and click 'OK'.
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14. Close the library.

You now need to include this layout in your overall page layouts.

15. Go to the Design tab and locate the layout selector called 'BestSellersListSidebar' – which currently inserts the best sellers list into the sidebar.
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If it has a fixed layout assigned to it, it might look like this:
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16. Replace the  layout selector with the following code:

<actinic:variable name="BestSellersSnippet" if="%3cactinic%3avariable%20name%3d%22PageType%22%20%2f%3e%20%3d%3d%20%22Search%22" />

<a rel="fragment" href="bs-snippet.html">Best Seller List Inserted Here</a>
In the page design, it will look like this:
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In the preview you will just see the 'Best Seller List Inserted Here' message, but when you upload the store and view it online, the list should appear correctly.

Note: There is a condition embedded within the 'BestSellersSnippet' layout selector that says 'PageType = "Search"'. This just means the 'bs-snippet.html' file only gets generated by one page in the store – the search page - but it can be included in any page in the store.

Also, the <a rel="fragment" href="filename.html">...</a> tag can be used to include any fragment of HTML into the design online.

Taking People Straight to a Product

It is possible to take people straight to a specific product with a hyperlink of the following form:

http://your.URL/cgi-bin/ss00000x.pl?PRODREF=12345&NOLOGIN=1

Where:

· http://your.URL/cgi-bin is the URL of your CGI-BIN

· ss00000x.pl is the name of your search script with the 'x' replaced with your CGI ID number

· 12345 is the product reference of your desired product. 

· &NOLOGIN=1 is an essential thing to add to the end of the URL to order to bypass the login page
Linking from Other URLs

Note: If you are using this code from outside the 'acatalog' folder then you will need to include a hidden form field of 'ACTINIC_REFERRER=' where the value is your 'Catalog URL' from 'Web | Network Setup'. For example:

http://your.URL/cgi-bin/ss00000x.pl?PRODREF=12345&NOLOGIN=1&ACTINIC_REFERRER=http://your.URL/acatalog/
Taking People Straight to a Section

If you want to create a link to a section in a store, then use a link of the following form...

http://your.URL/cgi-bin/ss00000x.pl?SECTIONID=Section%5fPage%2ehtml&NOLOGIN=1
Where:

· http://your.URL/cgi-bin is the URL of your CGI-BIN

· ss00000x.pl is the name of your search script with the 'x' replaced with your CGI ID number

· Section%5fPage%2ehtml is the filename of your desired page. Note that you have to encode any non-alphanumeric characters so an underscore '_' becomes '%5f' and a full stop '.' becomes '%2e'.

· &NOLOGIN=1 is an essential thing to add to the end of the URL to order to bypass the login page
Linking from Other URLs

Note: If you are using this code from outside the 'acatalog' folder then you will need to include a hidden form field of 'ACTINIC_REFERRER=' where the value is your 'Catalog URL' from 'Web | Network Setup'. For example:

http://your.URL/cgi-bin/ss00000x.pl?PRODREF=12345&NOLOGIN=1&ACTINIC_REFERRER=http://your.URL/acatalog/
and also 

<INPUT TYPE=HIDDEN NAME="ACTINIC_REFERRER" VALUE="http://your.URL/acatalog/">

Viewing the Shopping Cart from Anywhere on the Internet

The page that shows a summary of the shopping cart details is actually displayed as a result of a call to an online Perl script in the cgi-bin directory.

Go to your online website and click the 'view cart' button on the navigation bar. Even with nothing in your shopping cart, the address of the page in the 'Address' bar of your browser will be something like:

http://your.URL/cgi-bin/ca000001.pl?ACTION=SHOWCART  

This link will work when the call has come from inside the 'acatalog' folder online, but it might not work from outside. If it doesn't, you will need to add an 'ACTINIC_REFERRER=' parameter that tells the browser where your 'acatalog' folder is. This is the 'Catalog URL' value, which can be seen in 'Web | Network Setup'.

If your Catalog URL is 'http://your.URL/acatalog/' then the call to the shopping cart becomes:

http://your.URL/cgi-bin/ca000001.pl?ACTION=SHOWCART&ACTINIC_REFERRER=http://your.URL/acatalog/

Adding to Cart from Anywhere on the Internet
The following URL shows you the format to follow to add a product to the cart from anywhere on the Internet.

http://your.URL/cgi-bin/ca000001.pl?SID=3&PAGE=PRODUCT&Q_7=5

The SID parameter should be the section ID of the section where the product can be found. You can figure out the exact SID by inserting the 'SectionID' variable somewhere in your store pages and see what it becomes in the previewed page.
The Q_ parameter informs the script about the product reference and the quantity. The product reference is the (CGI encoded) string prefixed by Q_ while the quantity is the parameter value (prod ref is 7, qty is 5 in the above example). 

If you are adding from outside the 'acatalog' folder, then ensure you add

ACTINIC_REFERRER=http://your.URL/acatalog/

onto the end of the URL.

Obviously this works only for products where components, attributes, date or other info prompts are not used. However these more complex products can also be added to the cart on similar way but more parameters are required (check the HTML source of your product page for hidden input parameters to see what else required in these cases). 

The result of this script call may vary depending on the "Shopping mode" setting of the section where the product is located. E.g. if your product is located in a section where "Quantity on Product Page" shopping mode is used then using this link the product will be added to the cart and a bounce page will drop you back to the last used shop page, but if the shopping mode is "Quantity in Shopping Cart" then the cart will be displayed clicking on the link. 

Note that this solution is not supported by Actinic Software therefore you should use this at your own risk. 

Going Straight to the Checkout after Adding to Cart

This solution will take customers straight to the checkout after adding product to the cart from a page with a shopping mode of  'Quantity on Product Page' with a single add to cart button per page. This is set in the ‘Page Settings' tab of the section.
To begin, you need to create a new user-definable variable called 'GoDirectToCheckout' which you can use to control which sections will take the customer directly to the checkout after adding to cart.

1. Go to 'Design | Library | Variables'.

2. Right-click on the 'Section' group and select 'New Variable'.

3. Give it a name of 'GoDirectToCheckout'.

4. Give it a prompt of 'Take Customer Directly To Checkout?'.

5. Under 'Place Of Setting' select 'Section'.

6. De-select 'Allow <Use Parent> as an Option'.

7. Under 'Type' select 'True/False'.

8. Set 'Initial Value' and 'Top Level Value' both to 'False'.
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9. Click 'OK' and close the library.
You are now ready to include the code in your design.

10. Set up a section with a 'Shopping Mode' of 'Single Add To Cart Button' where you want to take customers directly to the checkout after adding to cart.

11. Change to the 'Design' tab.

12. Click on the single add to cart button in the design. 

In the layout code for the single 'add to cart' button, copy and paste the following code:

<actinic:block if="%3cactinic%3avariable%20name%3d%22GoDirectToCheckout%22%20%2f%3e%20%3d%3d%20true">

<input type="hidden" name="ACTION" value="<actinic:variable name="CheckoutButton" />">

<input type="hidden" name="CHECKOUTURL" value="<actinic:variable name="OrderLinkText" />" target="_self">

</actinic:block>
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Now for any section where you want to take your customers directly to the shopping cart after adding to cart, go to the 'Properties' tab of the section and set 'Take Customer Directly To The Checkout?' to 'True'.
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Stopping People from Checking Out with Less Than 2 Items

This code will prevent customers from checking out unless they have at least two items in their shopping cart. 

Go to the 'Design' tab and select 'Checkout Page 1' from the 'Select Page Type' drop-down list.

Click on the 'Next>' button in the design. 

Replace the code in the 'Checkout Next Button' layout with the following:

<script language="JavaScript">
<!--
/************************************************************/
*
* getCartItem
-
Gets the Actinic Cart Value & No of Items
*
*************************************************************/

//CART_CONTENT = Cookie name
//1 = TOTAL_VALUE
//3 = CART_COUNT

function getCartItem(index)

{

var act_cart= getCookie("CART_CONTENT")

temp =(act_cart != null) ? temp=act_cart.split("\t"):0;

return (temp.length > 0) ? temp[index] : 0;

}
// -->
</script>

<input type=SUBMIT name=ACTION value="<actinic:variable encoding="html" name="NextButton" />" onclick="if (getCartItem(3) >= 2) {return true;} else {alert('Minimum order is 2 items');return false;}">


It will look like this:
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Where it says 

if (getCartItem(3) >= 2)

the '2' can be replaced with another minimum quantity.

Emptying The Cart When People Leave The Checkout

This JavaScript function will empty your customer's shopping cart when they click the 'Cancel' button on the checkout. It is useful as sometimes it is confusing for customers if they still have items in their shopping cart, when they think they have cancelled the transaction.

To begin, place the following JavaScript functions in the <head> area of the overall page layout that is being used in the checkout. You can verify this in the 'Checkout Pages Layout' field in 'Settings | Site Options | Layouts'.

Add it in just above the closing </head> tag.

<script language="Javascript" type="text/javascript">
function createCookie(name,value,days) {
   if (days)
   {
      var date = new Date();
      date.setTime(date.getTime()+(days*24*60*60*1000));
      var expires = "; expires="+date.toGMTString();
   }
   else var expires = "";
   document.cookie = name+"="+value+expires+"; path=/";
}

function CancelOrder() {
   if (confirm('This will clear your order and address details completely.\nClick "View Cart" to change your order.\nDo you wish to proceed?') == true)
   {
      createCookie("ACTINIC_CART","",-2);
      createCookie("CART_CONTENT","",-2);
      createCookie("CART_COUNT","",-2);
      createCookie("CART_TOTAL","",-2);
      createCookie("ACTINIC_BUSINESS","",-2);
      createCookie("ACTINIC_REFERRER","",-2);
      window.location.href = 'http://www.YOURSITE.com/RETURN-PAGE';
   }
}
</script>

Replace 'http://www.YOURSITE.com/RETURN-PAGE' with the location of a page you want to take customers to.
Then go to 'Design | Library | Layouts' and locate the 'Checkout Button' group. Within it, locate 'Checkout Cancel Button' and double-click on it to open it.

Replace the code in the file with the following:

<input type="button" name="ACTION" value="<actinic:variable encoding="html" name="CancelButton" />" class="input" onclick="CancelOrder();" />
Asking People to Verify Their Email Address

This technique will replace the single 'Email' field in the checkout with two email fields, and the customer will not be able to continue until their email addresses match.

To do this, go to the 'Design' tab and from the 'Select Page Type' list select 'Checkout Page 1'.

Locate the 'Email Address' field in the checkout and click on it. You should now be within a layout called 'Invoice Email'.
Look for the line within the layout:

[image: image120.png]<input type="text" nawe="INVOICEEMAIL" size="20" maxlength="255" value="InvoiceEmail" />




REPLACE the line with the following code:

<input type="TEXT" name="INVOICEEMAIL" id="email1" size="20" maxlength="255" value="<actinic:variable name="InvoiceEmail" />">

<!-- start Check email address -->

      <br>

      Repeat email address:

      <br>

      <input type="TEXT" name="DUMMY" id="email2" size="20" maxlength="255" value="<actinic:variable name="InvoiceEmail" />">

<script language=JavaScript>

<!--

function checkemailaddress()

  {

  if ( document.getElementById('email1').value != document.getElementById('email2').value )

    {

    alert('The Email addresses do not match');

    return false;

    }

return true;

}

// -->

</script>

<!-- end Check email address -->
Then further down the page, click on the 'Next >' button to open the layout called 'Checkout Next Button'.

REPLACE the entire contents of the layout with the following code:

<input type="submit" name="ACTION" value="<actinic:variable encoding="html" name="NextButton" />" onclick="return checkemailaddress()" />
Then update your store and try out the email address checker.

Turning a Text Field into a Check Box

This is a neat trick that will turn any text field in the checkout into a check box. This will extend the ability of your Actinic store to take different types of information, and the responses will still look meaningful in the printed reports. 

This example is based on the 'User Definable' field in the 'Invoice Address' part of the checkout.

1. Go to 'Design | Text | Web Site (cont) | Invoice Address' and select the 'Show' box next to the 'Invoice User Defined' field.

2. Click 'OK'.

3. Next change 'Checkout Page 1' in the 'Select Page Type' field in the 'Design' tab. 

4. Click on the 'User Definable' text (or whatever you have changed it to).

5. Locate the following line:

[image: image121.png]<input type="text" name="INVOICEUSERDEFINED" size="20" maxlength="255" value="InvoiceUserDefined" />




6. This is the code for the user defined field, and by default it is a text field. Change the above code to read:

<input type="checkbox" name="INVOICEUSERDEFINED" value="CHECKED" <Actinic:Variable Name="InvoiceUserDefined"/>>

This will turn the text field into a check box. This will stay checked if a customer leaves the invoice address page and then re-enters it for any reason. The value that will appear in the order processing reports to indicate whether the customer ticked the box is the word 'CHECKED'.

Adding 'Postcode Anywhere' to your Checkout

Mole-End software have developed a plug-in for incorporating 'Postcode Anywhere' into your store. This is a system available in the UK where a customer can enter their postcode, and the rest of their address details will be automatically populated.

The URL for the solution is: http://www.mole-end.biz/acatalog/PostCodeAnywhereDef.html

Automatically Capitalising Customer Input

Customers will not always enter their name and address information with capital letters online. This then means you will often have to manually edit the details once you have receive the order into Actinic.
This is a JavaScript function that will apply correct capitalisation to the details customers enter in your checkout as they type them.

First of all, you need to go to the 'Design' tab and select 'Checkout Page 1' from the 'Select Page Type' drop down list. Then locate the overall page layout and insert the following function into the <head> section, just above the </head> tag.

<script language=JavaScript>

<!-- 

function capitalizeWords(string) { 

 var tmpStr, tmpChar, preString, postString, strlen; 

 tmpStr = string.toLowerCase();

 stringLen = tmpStr.length;

 if (stringLen > 0) 

  { 

  for (i = 0; i < stringLen; i++) 

   { 

   if (i == 0) 

    { 

    tmpChar = tmpStr.substring(0,1).toUpperCase(); 

    postString = tmpStr.substring(1,stringLen);

    tmpStr = tmpChar + postString; 

    } 

   else 

    { 

    tmpChar = tmpStr.substring(i,i+1);

    if (tmpChar == " " && i < (stringLen-1)) 

     { 

     tmpChar = tmpStr.substring(i+1,i+2).toUpperCase();

     preString = tmpStr.substring(0,i+1); 

     postString = tmpStr.substring(i+2,stringLen);

     tmpStr = preString + tmpChar + postString; 

     } 

    } 

   } 

  } 

 return tmpStr; 

}

// -->

</script>

Once you have done that, you can click on any fields in the page that you want capitalised, and just add in the call to the function. For example, replace:

<input type="text" name="INVOICENAME" size="20" maxlength="40" value="<Actinic:Variable Name="InvoiceName"/>" />
with

<input type="text" name="INVOICENAME" size="20" maxlength="40" value="<Actinic:Variable Name="InvoiceName"/>" onchange="this.value = capitalizeWords(this.value)" />
i.e. add the following into any <input> tag where you want the contents capitalised:
onchange="this.value = capitalizeWords(this.value)"
Optimising Page Titles For Search Engines

By default, Actinic will automatically create a page title for your section pages which is the company name followed by the section name. You can overwrite this by enter a value in the 'Page Title' field within the 'Page Settings' tab of a section. It is, however, possible to edit the automatically generated page titles for all your sections.
To do this, you need to locate the <title></title> field within the overall page layout of your section pages. This will contain a variable called PageTitle.

Replace the PageTitle variable with the following code:
<actinic:block if="%3cactinic%3avariable%20name%3d%22PageType%22%20%2f%3e%20%3d%3d%20%27Section%27"><actinic:block if="%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3e%200"><actinic:variable name="SectionName" />, <actinic:variable name="CompanyName" /></actinic:block><actinic:block if="%3cactinic%3avariable%20name%3d%22SectionLevel%22%20%2f%3e%20%3d%3d%200"><actinic:variable name="CompanyName" /></actinic:block></actinic:block><actinic:block if="%3cactinic%3avariable%20name%3d%22PageType%22%20%2f%3e%20%3d%3d%20%27Brochure%27"><actinic:variable name="BrochureName" />, <actinic:variable name="CompanyName" /></actinic:block><actinic:block if="%28%3cactinic%3avariable%20name%3d%22PageType%22%20%2f%3e%20%21%3d%20%27Section%27%29%20AND%20%28%3cactinic%3avariable%20name%3d%22PageType%22%20%2f%3e%20%21%3d%20%27Brochure%27%29" ><actinic:variable name="PageType" />, <actinic:variable name="CompanyName" /></actinic:block>
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All the conditions (green 'block' tags) are there to show different titles on different types of pages.

Supporting an Affiliate Program with Actinic Ecommerce

It is possible to add markup to the Actinic's receipt page in order to support an affiliate program. The markup is generally specified by the affiliate program, but a typical example would be:

<IMG SRC="https://www.server.com/log.cgi?amount=[order-amount-here]&orderid=[order-id-here]">

Translating this into a Actinic ready line, you would get:

<IMG SRC="https://www.server.com/log.cgi?amount=NumericOrderTotal&orderid= TheOrderNumber">

The variables available to an affiliate program of this nature are:

TheOrderNumber - order number.

FormattedOrderTotalHTML - the order total formatted in the appropriate currency and encoded for HTML display

e.g. &#163;55&#46;57

FormattedOrderTotalCGI - the order total formatted in the appropriate currency and encoded for CGI

e.g. %a355%2e57

ActinicOrderTotal - the order total formatted in the Actinic internal format (integer number in currency base unit)

e.g. 5557

NumericOrderTotal - the order total partially formatted in the appropriate currency. This value include decimal and thousand separators, but leaves off the currency symbol.

e.g. 55.57

NumericOrderTotalCGI - the order total partially formatted in the appropriate currency and encoded for CGI.  This value include decimal and thousand separators, but leaves off the currency symbol.

e.g. 55%2e57

TextOrderTotal – The order total with currency symbols and a decimal point, with no encoding.

e.g. £55.57
Multiple Currency Conversion

By default, Actinic cannot support multiple currency conversion. However, it is possible to embed the Universal Currency Converter( (produced by Xenon Laboratories Inc) within your Shopping Cart and your Checkout. The Universal Currency Converter( can appear as either an embedded frame or as a floating window. It will take the value from the Shopping Cart and present you with a range of currencies to convert the value into. The Universal Currency Converter( is updated in real time to give you all the accuracy you will need.

In order to incorporate the Universal Currency Converter( into your catalogue:

First you have to register with Xenon Laboratories at http://www.xe.net/ecc/shoppers/. 

Once you have done this, insert the following JavaScript expression into your overall page layout, just above the </head> tag. 

<SCRIPT language="JavaScript">

  function CurrencyPopup(QueryString)

  {

    CurrencyWindow = window.open ('', 'CurrencyWindow', 'toolbar=0,location=0,directories=0,status=0,menubar=0,scrollbars=0,resizable=1,height=170,width=600')

    CurrencyWindow.focus()

    CurrencyWindow.location.href = 'http://www.xe.net/ecc/input.cgi?Template=sw&'+QueryString

  }

</SCRIPT>

Note: It will be much more reliable to get this code from the actual Xenon Laboratories site at http://www.xe.com/ecc/shoppers/

Next, select 'Shopping Cart' from the 'Select Page Type' drop down list on the 'Design' tab.

Click on the 'Shopping Cart' title above the grid to open the layout called 'View Cart Page Shopping Cart Grid'. Scroll down to the bottom of this layout until you find: 

</Actinic:XMLTEMPLATE>

Just above this line, enter the following:

<IFRAME SRC="http://www.xe.net/ecc/input.cgi?Template=se&Amount=<actinic:variable name="Total" />&From=GBP" WIDTH=600 HEIGHT=150 NAME="Currency" FRAMEBORDER=0 SCROLLING=NO> 

<TABLE WIDTH=550 CELLPADDING=0 CELLSPACING=0 BORDER=0 BGCOLOR=#F0C090><TR><TD><TABLE WIDTH=100% CELLSPACING=1 CELLPADDING=0 BORDER=1><TR><TD WIDTH=15% BGCOLOR=#000000 ALIGN=CENTER VALIGN=MIDDLE ALIGN=CENTER><A HREF="javascript:CurrencyPopup('Amount=<actinic:variable name="Total" />&From=GBP')"><IMG SRC="http://www.xe.net/currency/illegal2copy.gif" HEIGHT=45 WIDTH=45 BORDER=0 ALT="UCC" ALIGN=TEXTTOP></A></TD><TD bgcolor=#FFFFC0 VALIGN=MIDDLE><TABLE CELLPADDING=3 CELLSPACING=0 BORDER=0><TR><TD VALIGN=MIDDLE>   </TD><TD><FONT COLOR=#000000 face="Arial,Helvetica"><FONT SIZE=+1><b>Shopper's Currency Converter</B>&#153; </FONT><FONT SIZE=-1>by Xenon Labs<BR><B>Your browser does not support embedded frames. <A HREF="javascript:CurrencyPopup('Amount=<actinic:variable name="Total" />&From=GBP')">Click here</A> to pop open a floating Shopper's Currency Converter&#153; window.</B></FONT></FONT> </TD></TR></TABLE> </TD></TR></TABLE> </TD></TR></TABLE> 

</IFRAME>

Again, it will be much more reliable to get the original code from the actual Xenon Laboratories site at http://www.xe.com/ecc/shoppers/ (under the heading of 'Building a Query String') and then make the changes that are highlighted in red. 

Specifying a Delivery Cut-Off Time for Orders

This section will show you how you could add a warning to your site that tells people whether their order will be sent the same day.

Simply place the following code into your product layout where you want the message to appear:

<script language=JavaScript>
  now = new Date();
  if ( now.getHours() >= 16 ) document.write('<span style="color:red;">Warning text here</span>');
</script>

In the above example, the cut-off time is 4pm - 16.00. If you want a different time, change the '16' to another number on the 24 hour clock.

You can also put this code into the overall page layout for the store.

Using an Email Link that is Invisible to Spammers

When you include a link of the format:

<a href="mailto:sales@domain.co.uk">click to email us</a>

...it can be picked up by email address harvesters and used to build spam lists.

The following code will look the same to customers, but will protect your email address:

<script type=text/javascript>
var _u = "sales";
var _d = "domain.co.uk";
var _l = _u + "@" + _d;
var _m = "click to email us";
document.write("<a href='mailto:"+_l+"'>"+_m+"</a>");
</script> 

Change the 'sales' and 'domain.co.uk' to your own email address.

Hiding Elements from Retail Customers, but Showing Them to ALL Registered Customers

If you have a design element in your site that you only want to show to registered customers, and hide from retail customers, then you need place the following tags before the code:

<Actinic:NOTINB2B><!--</Actinic:NOTINB2B>

…and put these after the code:

<Actinic:NOTINB2B>--></Actinic:NOTINB2B>

This will mean that the HTML comment marks will only appear for unregistered customers, and hence the content will be hidden from them.

Preventing Unregistered Customers from Entering Certain Sections in your Store

It is possible to have sections that only customers within certain customer groups will see online. To do this, you need to create a new section link template with a very specific format.

Go to 'Design | Library | Layouts' and locate the 'Section Links' group. 

Right-click on any of the layouts there and select 'New Layout'. Call it 'Section Link for Registered Customers Only'.

Now double-click on this layout to edit it, and copy and paste the following code into it, in place of any existing code:

<Actinic:SHOWFORPRICESCHEDULE Schedules="2" HTML="<a href=<actinic:variable name="SectionPageName"/>><actinic:variable name="SectionName"/></a>"/>
You can then select this layout within the 'Section Link Layout' field in the 'Section' tab of any section that you want to be hidden.

You have to change the code in this template depending on which customer groups you want the section link to be visible within. The Schedules="2" value needs to be the ID of your desired customer group. You can find this from the 'Price Schedules' table in the 'ActinicCatalog.mdb' database.

Note: This section really needs to be at the end of a list of sections, Otherwise unregistered customers will have a gap appearing where the link should be.

Bouncing Unregistered Customers Out of Sections

If you wish to prevent unregistered customers from being able to view specific store pages, then you will need to include a simple JavaScript function into the overall page layout for those sections. 

1. Go into the 'Layout' tab of the section that you want to restrict to only registered customers.

2. Locate the 'Overall Page Layout' field and make a mental note of the name of the current overall page layout.

3. Click in the 'Overall Page Layout' field and select '<New>' from the bottom of the list.

4. In the 'Based On' field, select the overall page layout that is currently being used by the section.

5. In the 'Name' field enter 'Registered Customers Only'.

6. Click 'OK' and then click 'Apply' to make this section use the new layout.

7. Now change to the 'Design' tab and select the overall page layout.

8. Locate the following command in the headers of the template:

<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1">

9. Just underneath this, copy and paste the following into the template:

<Actinic:NOTINB2B> 
<meta http-equiv="Refresh" content="0; url=NoEntry.html"> 
</Actinic:NOTINB2B> 
<script language="javascript1.1"> 
function actNotRegistered(){ 
//<Actinic:NOTINB2B> 
location.replace ('NoEntry.html'); 
//</Actinic:NOTINB2B> 
} 
</script>

Note: replace page.html with whatever page you want unregistered customers to be bounced to.

10. Next, locate the <body> tag further down in the layout:

[image: image123.png]<body onload="PreloadImages">




11. Change the 'onload' part to read:

[image: image124.png]<body onload="PreloadImages;actNotRegistered() ">




Whatever sections you don't want unregistered customers going into, specify this new layout in the 'Overall Page Layout' field. This should now automatically take customers back to the designated page if they try and go to a page in your store that you do not want them to. 

Naturally, you are going to want to have some explanation in the section description of the section to point out that certain sections are for trade customers only.

Allowing Customers to Register for Accounts Online

Although it is not possible for a customer to create a customer account whilst browsing online, it is possible for storeowners to include a product that simulates the registration process.
To start the process you need to make it possible to set the add to cart button layout and the edit the text on the add to cart button for an individual product.

1. Go to 'Design | Library | Layouts'.

2. Within the 'Add To Cart Button' group double-click on the 'AddToCartButton' layout selector.

3. Under 'Place of Setting' select 'Product' and click 'OK'.

4. Now change to the 'Variables' tab.

5. Expand the 'Product' group and double-click on 'CartButtonText'.

6. Again, under 'Place of Setting' select 'Product'.

7. Click 'OK' and close the library.

8. Create a new product somewhere in your store (top level is normally a good idea) called 'Register for an account' (or something similar).

9. Within the full description, enter text similar to the following:

Click the button below to register for an account with us. 

On the next screen, click !!<<b>Checkout now</b>>!! and then supply us with your invoice and delivery details in the pages that follow.

!!<<b>Please Note:</b>>!! We will be in contact you via email when your account is ready.

10. Within the 'Add To Cart Button Layout' field in the 'General' tab select 'Add To Cart Button'.

11. Within the 'Text For Cart Button' field type "Register Now"

You need not fill in any other fields. You must be especially sure that you do not enter a price. 

Now, when people order this 'product' online, you can turn their invoice and delivery details into a customer account by clicking the 'Create Customer Account' button within the 'Contact' tab of the order. 

If you are using weight-based shipping then make sure this product has a weight of '0' and then in 'Business Settings | Shipping and Handling', make sure that orders with a weight of '0' get charged '0.00' shipping.

Preventing Search Engines from Indexing Certain Pages

As you may know, search engines will 'spider' through all your pages on your website and make a note of the content of each page. This is great for your store pages, as customers can search on words that are on your pages, but there may be certain pages in your store that you do not want search engines finding.

1. Go into the 'Layout' tab that of the section that you want hide from search engines.

2. Locate the 'Overall Page Layout' field and make a mental note of the name of the current overall page layout.

3. Click in the 'Overall Page Layout' field and select '<New>' from the bottom of the list.

4. In the 'Based On' field, select the overall page layout that is currently being used by the section.

5. In the 'Name' field enter 'Hidden From Search Engines'.

6. Click 'OK' and then click 'Apply' to make this section use the new layout.

7. Now change to the 'Design' tab and select the overall page layout.

8. Within the <head> section of the layout, enter the following line:  

<META NAME="robots" CONTENT="none">

You can now specify this file as the overall page layout for any pages that you do not want indexed.

Section C: Perl Script Changes

Using Images for the Checkout Buttons

You can use images for the 'Next', 'Back' and 'Cancel' buttons in the checkout. This requires a little Perl customisation, so please carry out the steps in this exercise with care.

To begin, use the 'Select Page Type' drop-down in the 'Design Tab' to change to the 'Checkout Page 1' page. Scroll down until you find the three grey 'Next', 'Back' and 'Cancel' buttons.
Click on the '<Back' button and replace 

[image: image125.png]<input type="submit" name="ACTION" value="BackButton" />




with

<input type="image" name="ACTION_BACK" src="back.gif" />

Next, click on the 'Cancel' button and replace 

[image: image126.png]<input type="submit" name="ACTION" value="CancelButton" />




with

<input type="image" name="ACTION_CANCEL" src="cancel.gif" />

Finally, click on the 'Next>' button and replace

[image: image127.png]<input type="submit" nawe="ACTION" value="NextButton" />




with

<input type="image" name="ACTION_NEXT" src="next.gif" />

This is all assuming 'back.gif' is the image you want to use for the back button, 'cancel.gif' is the image you want to use for the cancel button and 'next.gif' is the image you want to use for the next button. These images need to already be in your 'Site1' (or equivalent) folder.
Next, locate 'OrderScript.pl' within your 'Site1' (or equivalent) folder with Notepad and find the following code:

@Response = ReadAndParseBlobs(); 

# read the catalog blobs
($Status, $Message) = @Response; 

# parse the response
if ($Status != $::SUCCESS)
        {
        ACTINIC::ReportError($Message, ACTINIC::GetPath());
        }

Underneath it, copy and paste the following code:

if(!defined $::g_InputHash{"ACTION"})
  {
  if(defined $::g_InputHash{"ACTION_BACK.x"})
          {
          $::g_InputHash{"ACTION"} = ACTINIC::GetPhrase(-1, 503);
          }
  elsif(defined $::g_InputHash{"ACTION_CANCEL.x"})
          {
          $::g_InputHash{"ACTION"} = ACTINIC::GetPhrase(-1, 505);
          }
  elsif(defined $::g_InputHash{"ACTION_NEXT.x"})
          {
          $::g_InputHash{"ACTION"} = ACTINIC::GetPhrase(-1, 502);
          }
      }

Save and close the template and upload to see your new button images. If it does not work, there is an untouched OrderScript.pl within the 'Original' folder in your Actinic installation, which you can copy into your 'Site1' (or equivalent) folder. 

Using Images for the 'Change Location' Button

You can also use images for the 'Change' buttons that appear next to the location you have selected

To go this, go to 'Design | Text', click on the 'Go To' button and enter 'Phase' -1 and 'ID' 2067. This will take you to the following prompt

<table width="100&#37;" border="0" cellspacing="0" cellpadding="0">

<tr>

<td align="left">%s%s%s<input type="hidden" name="%s" value="%s" /></td>

<td align="right"><input type="submit" name="ACTION" value="%s" /></td>

</tr>

</table>
Change:

<input type="submit" name="ACTION" value="%s" />
to:

<input type="image" name="ACTION_CHANGELOCATION" src="image.gif" />

where 'image.gif' is the name of your image.

Next, open 'OrderScript.pl' before the code that you input as part of the 'Images for Checkout Buttons' code as mentioned above, you need to enter:

if(!defined $::g_InputHash{"ACTION"})
  {
  if(defined $::g_InputHash{"ACTION_CHANGELOCATION.x"})
          {
          $::g_InputHash{"ACTION"} = ACTINIC::GetPhrase(0, 18);
          }
}

This bit must be part of a separate if statement to the other buttons or it won't work.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Adding Extra Fields to the 'Contact Us' Form

To create new fields in the 'Contact Us' form you need to:

1. Go to the 'Design' tab in the 'Select Page Type' drop-down list select 'Contact Us'.
2. Click on one of the prompts on the page (e.g. 'Message') to select the 'Contact Us Bulk Area' layout.

3. Add a new row where you want the field to display using the following 
code:
<tr> 
   <td>&nbsp;</td>
   <td>My New Field Name:</td>
   <td><input type="text" name="MyNewField" size="50" maxsize="125" value="" /></td>
</tr>

4. If the field is to be required then change the field prompt to look 
like:
<td><span class="actrequiredcolor">My New Field Name:</span>*</td>
5. Save and close the  file
You now need to edit the Perl script that controls the message sending.

6. Open 'Windows Explorer' and browse to C:\Program Files\Actinic v8\Sites\<site name>
7. Open 'MailForm.pl' in a text editor such as Notepad.
8. Search for: 'sub SendMailToMerchant'

9. You should see the following line:

# Receive parameters from input hash
#
my ($sEmailRecpt, $sSubject, $sTextMailBody, $sName, $sMessage, $sHTML);

10. Add in $sMyNewField, so it looks something like

# Receive parameters from input hash
#
my ($sEmailRecpt, $sSubject, $sTextMailBody, $sName, $sMessage, $sMyNewField, $sHTML);

11. You need to create a variable for each extra field that you want to 
display so after :

$sSubject = $::g_InputHash{'Subject'};

add a similar line for each field, for example:

$sMyNewField   = $::g_InputHash{'MyNewField'};

12. Then search for: '# Construct the mail text and send it to the merchant'
13. You need to add a line for each field after:

$sTextMailBody .= ACTINIC::GetPhrase(-1, 2373) . "\r\n" . $sMessage . "\r\n\r\n";

for example:

$sTextMailBody .= "MyNewFieldName:" . $sMyNewField . "\r\n";

14. Then directly after these new fields you should see:

my @Response = ACTINIC::SendMail($::g_sSmtpServer, 
$$::g_pSetupBlob{EMAIL}, $sSubject, $sTextMailBody, $sEmailRecpt);

15. You need to add in your new variables so they are sent with the email, for example:

my @Response = ACTINIC::SendMail($::g_sSmtpServer, 
$$::g_pSetupBlob{EMAIL}, $sSubject, $sTextMailBody, $sEmailRecpt, $sMyNewField);


16. A little further down you should see the above line again - under:

 # Send the same message to the sender
 # With a "thank you" prefix

17. Make the same change

18. If you want to make your new field to be required then you need to search for:

if ($sEmailRecpt eq "")
 {
 $sError .= ACTINIC::GetRequiredMessage(-1, 2371);
 }

19. Copy this code and paste it directly after it and change the relevant 
parts, i.e.:

if ($sMyNewField eq "")
 {
 $sError .= "<b>'My New Field'</b> is required<br>";
 }

20. Save and close the file and update your site.
Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Creating a Newsletter Subscription Form
It is possible to use the above technique to turn your 'Contact Us' form into a 'Subscribe To Newsletter' form. To do this, first of all you need to edit the 'Contact Us Bulk Area' layout to look like as follows.

This will add two new fields into the form  - 'Surname' and 'Subscribe'. It will also change the 'Message' field to a 'Country' field.

<form method="post" action="<Actinic:Variable Name="SendMailPageURL"/>">

<input type="hidden" name="RANDOM" value="<actinic:variable name='Random'/>" />

<actinic:block if="%3cactinic%3avariable%20name%3d%22IsHostMode%22%20%2f%3e">

   <!-- Hidden field when in trial mode -->

   <input type="hidden" name="SHOP" value="<Actinic:Variable Name="HiddenFields"/>" />

</actinic:block>

<actinic:variable Name="ValidationError"/>

<input type="hidden" name="Subject" value="Newsletter" /> 

<table cellpadding="3" cellspacing="0">

   <tr> 

      <td width="15">&nbsp;</td>

      <td colspan="2">

         <strong><Actinic:Variable Name="MailFormHeader"/></strong><br /> 

         <br />

      </td>

   </tr>

   <tr> 

      <td>&nbsp;</td>

      <td>

         Forename

      </td>

      <td>

         <input type="text" name="Name" size="50" value="<Actinic:Variable Name="MailFormNameValue"/>" /> 

      </td>

   </tr>

     <tr> 

      <td>&nbsp;</td>

      <td>

         Surname

      </td>

      <td>

         <input type="text" name="Surname" size="50" value="" /> 

      </td>

   </tr>

   <tr> 

      <td>&nbsp;</td>

      <td>

      </td>

      <td>

         Subscribe: <input type="radio" checked="checked" name="Subscribe" value="yes" /><br />

         Unsubscribe: <input type="radio" name="Subscribe" value="no" />

      </td>

   </tr>

   <tr> 

      <td>&nbsp;</td>

      <td>

         <span class="actrequired"><Actinic:Variable Name="MailFormEmail"/> *</span>

      </td>

      <td>

         <input type="text" name="EmailAddress" size="50" value="<Actinic:Variable Name="MailFormEmailValue"/>" /> 

      </td>

   </tr>

   <tr> 

      <td valign="top">&nbsp;</td>

      <td valign="top">

         Country: 

      </td>

      <td>

         <input type="text" size="50" name="Message" value="<Actinic:Variable Name="MailFormMessageValue"/>" />

      </td>

   </tr>

   <tr> 

      <td valign="top">&nbsp;</td>

      <td valign="top">&nbsp;</td>

      <td>

         <input type="submit" name="ACTION" value="<Actinic:Variable Name="MailFormSendButton"/>" />

      </td>

   </tr>

   <tr> 

      <td valign="top">&nbsp;</td>

      <td colspan="2" valign="top">

         <Actinic:Variable Name="RequiredFields"/> <span class="actrequired"><Actinic:Variable Name="Highlighted"/></span>.

      </td>

   </tr>

</table>

</form>
Next, you need to go into 'Design | Text' and go to Phase: -1, ID: 2370 and change the prompt there to 'First Name' (from Name). Then go down to ID: 2373 and change the prompt from 'Message' to 'Country'.

Finally, you need to edit the 'MailForm.pl' file as described above to add $sSurname and $sSubscribe to the list of values supported by the Perl. e.g.

# Receive parameters from input hash

#

my ($sEmailRecpt, $sSubject, $sTextMailBody, $sName, $sSubscribe, $sSurname, $sMessage, $sHTML);

and

$sSubscribe

= $::g_InputHash{'Subscribe'};

$sSurname

= $::g_InputHash{'Surname'};

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Using Dual Currency Pricing in the Store Pages But Not in the Cart

If you are showing prices in two currencies, but only want the prices in the shopping cart (and checkout) to show one currency, then you can fix this with a one line change in 'ActinicOrder.pm'. Locate this file in your 'Site1' (or equivalent) folder and open it in Notepad. Look for the line...

if($$::g_pSetupBlob{'PRICES_DISPLAYED'} && $$::g_pSetupBlob{'ALT_CURRENCY_PRICES'})

and change it to

if($::FALSE && $$::g_pSetupBlob{'PRICES_DISPLAYED'} && $$::g_pSetupBlob{'ALT_CURRENCY_PRICES'})

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.
Omitting Certain Products From Search Results

This is a change to the SearchScript.pl Perl script which will mean that any products that end in 'x' will not be shown in the search results. Note that the search results sequence numbers will show a missing result. 

Open SearchScript.pl within a text editor such as Notepad and locate the following line:

for ($nCount = $nMin; $nCount < $nMax; $nCount++) # process the range of product references in the results set

Immediately after this line add the 2 lines:

{




 # patch

if ( $$rarrResults[$nCount] !~ /x$/ ) # hide products that have reference ending in x

Then a little way below this, look for the pair of lines

$sHTML .= ACTINIC::ParseXML($sResultMarkup); # parse the XML

}

Immediately after this pair of lines add the single line

}  # patch
Then save the file and upload to test it. 
With grateful thanks to Norman Rouxel for this solution.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Manual Configuration of Advanced Searching

Creating Multiple Search Tools

The advanced search in Actinic is a powerful tool but there is a limitation in that Actinic will only ever generate a single search form on a single search page. This is limited if you have two different types of product in your online store and you would like to search on each product type individually.

In order to generate your own multiple search forms, you will first need to allow Actinic to get as far as it can automatically. For example, you might have an online store that has one section of DVDs and one section of CDs. Each DVD may have a 'Director' property whereas each CD may have a 'Artist' property.    

You can set up the 'Searchable Properties' tab to search on these two properties.
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Which will automatically create a corresponding search page.
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If you now upload this catalog (or go to 'Web | Generate Web Site') it will generate an HTML file called 'search.html' and a file called 'customsearch.fil' which you will find in your Site1 (or equivalent) directory. These are the files that you will need to customise.

Finally, go to 'Settings | Search Settings | Search Options' and un-check where it says 'Catalog Maintains Search Page'. This will mean that Actinic will no longer create any more search page HTML or a customsearch.fil file; even if you make a change to the search settings in the application. You are now able to customise these files to your exact specifications.

Editing the Search Page HTML

'search.html' is now a totally complete, fully functional HTML page that can be opened in any visual HTML editor such as 'Dreamweaver'.

When you open up this file for editing, please take note of the following:

The <form></form> tags of the search form are located right at the top and bottom of the main area of the page. Therefore if you are going to create multiple search forms on the same page, you will have to duplicate and relocate the <form…> and </form> tags to surround each separate HTML form.

You will need to ensure that any <input type="hidden"> elements are included correctly in each search form. 

You could begin by rearranging the HTML to create an independent search form to look something like this:

<p>What director are you looking for?</p>

<form method="get" action="http://your.URL/cgi-bin/ss000001.pl">

<input type="hidden" name="RANDOM" value="NETQUOTEVAR:RANDOM" />

<input type="hidden" name="PAGE" value="SEARCH" />
<select size="1" name="S_Director1_0">

<option value="Baz Luhrmann" selected>Baz Luhrmann 

...

... 

<option value="Stephen Spielberg">Stephen Spielberg

</select>

<input type=SUBMIT name=ACTION value="Search">

</form>
Notice that two hidden input fields are required to get the Perl to treat the form correctly.

Editing the 'customsearch.fil' Files

This online search will not work yet as we still need to create a 'customsearch.fil' file just for this form to use. 

When you open up customsearch.fil in Wordpad, you get something like this:

1

Price!PR

Text!SS!TB

And

Text Property!S_Director1_0

And

Text Property!S_Artist1_1

And

(In Notepad, the line breaks will appear as black blobs)

This file tells the online search which values to look for in the catalogue and how the results are to be combined with each other. 

A breakdown of this file is as follows:

	Value
	Line
	Explanation

	1
	Line 1
	Indicates format of file. Always begin the file with this line

	Price!PR
	Line 2
	This means that the search will be looking at the price fields of the products. This line will only be here if you are doing price-based searching.

	And
	Lines 4 , 6 & 8
	Indicates how the different search fields are to be combined with each other (the intersection). Set by choosing either 'AND' or 'OR' in the Searchable Properties tab.

Note that the 'And' or 'Or' refers to how the preceding line of code is to be combined with the other search fields.

	Text!SS!TB
	Line 3
	This means that the search will be scanning short and full descriptions for any keywords. 'SS' is the name of the keyword text field whilst 'TB' is the name of the 'combine keywords using' radio buttons. 

	Text Property!Whatever
	Lines 5 & 7
	The first part of this command refers to the type of data you are searching on. This can be one of the following:

· Price

· Text (keyword search only)

· Text Property 

· Integer

· Date

The second part ('Whatever') refers to the name of the form object.  


To edit the above 'customsearch.fil' file to work with an online form that is only looking for 'Directors', you will need to change it to the following:

1

Text Property!S_Director1_0
And then save it as something like 'customsearch2.fil'. The file name must be of the form 'customsearch#.fil'.  Ensure there are no blank lines at the bottom of the file.

In order to get your new search form to look for this 'customsearch#.fil' file you need to add a line of code to the search tool of the following form:

<input type=HIDDEN name="SN" VALUE="#">

Where '#' is the number used in the 'customsearch#.fil' file.

If you did save the file as 'customsearch2.fil', the HTML form code in the search page will now look like the following:

<p>What director are you looking for?</p>

<form method="get" action="http://your.URL/cgi-bin/ss000001.pl">

<input type="hidden" name="RANDOM" value="NETQUOTEVAR:RANDOM" />
<input type=HIDDEN name="SN" VALUE="2">
<input type="hidden" name="PAGE" value="SEARCH" />
<select size="1" name="S_Director1_0">

<option value="Baz Luhrmann" selected>Baz Luhrmann 

...

... 

<option value="Stephen Spielberg">Stephen Spielberg

</select>

<input type=SUBMIT name=ACTION value="Search">

</form>
In order to have Actinic to upload this new file, you will need to add it into the list in 'Design | Additional Files'. 

This technique can be expanded to create multiple search pages, each one with a different search tool on it.  Remember to add any additional search pages to the 'Design | Additional Files' list in order for them to be uploaded. Note that Actinic will not automatically link to any custom written search pages so you will have to write your own HTML to include these.

Joining Search Terms Together in Different Ways

You can also edit the 'customsearch.fil' file to join the search terms together in more complex ways.  For instance, in the case of a catalogue of films, you may wish people to choose either the director or the star of the movie they want, and then choose what genre (Thriller, Comedy etc.) of film they are interested in. E.g. "Find all action films starring Harrison Ford or directed by Steven Spielberg."

If you set up 'Director', 'Star' and 'Genre' as custom properties and set up the 'Searchable Properties' tab to search on them, the 'customsearch.fil' file generated would look something like the following:

1

Text!SS!TB

Text Property!S_Director1_0

And

Text Property!S_Star1_1

And

Text Property!S_Genre1_2

And
This file would still search on keywords, and would only find films that contain the director AND the star AND the genre chosen. You could make the 'Director' and 'Star' fields both optional (to allow people to search on either) but you could not search on the director OR the star at the same time, and then look for the genre.

However, you can do this by changing 'customsearch.fil' to something like the following:

1

Text Property!S_Director1_0

Text Property!S_Star1_1

Or

Text Property!S_Genre1_2

And
This code removes the references to the keyword search (allowing you to remove the keyword search box from the search page) and changes how the search properties are joined together.  Online, the search would act on this file in the following way: 

1. It would firstly see line 2 and find all the films of the chosen director (e.g. Steven Spielberg). It makes a list of them and stores them this list in its memory

2. It then would read line 3 and find all the films starring the chosen star (e.g. Harrison Ford) and adds this list to the director list and holds it in its memory.

3. The 'Or' in line 4 tells the search to combine both lists into one. If it was an 'And' then the search at this point would disregard all films starring Harrison Ford that were not directed by Steven Spielberg (and vice versa)

4. The search reads line 5 now and finds all the films of the chosen genre (e.g. Action), makes a list of them and stores them in its memory.

5. The 'And' in line 6 means that it will firstly compare the genre list with the director and star list, keeping the products that match. It disregards all the products that do not fulfil either criteria.

6. The products that match the required criteria are then displayed in the results page.

Remember that the 'And' or 'Or' command refers to how the preceding line is to be combined with the results gathered so far.

Keeping a Log of Search Terms Used at the Site

You can enable search term monitoring by editing ActinicConstants.pm and removing the comment (the '#') from the line:

#$::SEARCH_WORD_LOG_FILE        = "search.log";

Setting any non empty file name to $::SEARCH_WORD_LOG_FILE will result a log file. E.g.

$::SEARCH_WORD_LOG_FILE = "searchword.log";

… will create a file called 'searchword.log' in the acatalog directory on the web server.

The log file contains the following information:

        #       0 - date/time
        #       1 - browser name or IP address
        #       2 – referrer
        #       3 - customer ID
        #       4 - buyer ID
        #       5 - word list

These values are comma separated. E.g. entering word "Desk" on the search page as unregistered customer will result the following line in the log file:

2002/04/11 19:17, 10.3.4.1, http://10.3.4.2/actinic/acatalog/search.html,0,0,desk

If more than one search word is entered then the words are separated by spaces. E.g.

2002/04/11 20:00, 10.3.4.1, http://10.3.4.2/catalog-cgi/bb000241.pl,2,3,desk fan

Note: the "2, 3" means that this search was made by a registered customer where the customer ID is 2 and the buyer ID is 3.

Having a larger box for the 'Other Info' Prompt

By default, customers only have a single line to provide an answer for the 'Other Info' question online. It is possible to edit the product layout and the 'Design | Text' area to provide a 'text area' box instead of a single line

First of all, you just need to edit the 'Other Info' prompt that appears as part of your product layout on the store pages (if you are using a shopping mode of 'Quantity on Product Page'). 

To do this:

1. Select your product layout in the 'Design' tab and locate the following line:
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2. Replace this line with the following code:

<textarea name="O_<Actinic:Variable Name="ProductReference"/>" rows="5" cols="40" maxlength="1000" value="" /></textarea>

You now need to edit the code for the other info prompt that appears in the shopping cart. To do this:

3. Go to 'Design | Text'

4. Click 'Go To' and in the ID field enter '2161'.

5. It should highlight a line that says find a line that says:

%s<input type="text" name="%s" size="%d" maxlength="%d" value="%s" %s />
6. Change the prompt to read:

%s<textarea name="%s" rows="5" cols="40" %d maxlength="%d">%s</textarea>
7. Click 'OK' to save your changes.

8. Now go into your 'Site1' folder and locate a file called 'ActinicOrder.pm'. Open it in Notepad.

9. Search for '2161', you should see...

$sHTML = ACTINIC::GetPhrase(-1, 2161, "", $sIndex, 35, 1000, $sValue, $sStyle);
10. Comment out this line by preceding it with a #.

11. Insert the following immediately after the above line...

$sHTML = ACTINIC::GetPhrase(-1, 2161);
$sHTML =~ s/%d/%s/;
$sValue =~ s/%0a//ig;  # we seem to need to remove some Line Feeds here
$sHTML = sprintf( $sHTML, "", $sIndex, $sStyle, 1000, $sValue);
12. Save the file.

13. Now go into your 'Site1' folder and locate a file called 'OrderScript.pl'. Open it in Notepad.

14. Look for:-

if (length $$pProduct{'OTHER_INFO_PROMPT'} > 0)
{
MailOrderLine( "",
$$pProduct{'OTHER_INFO_PROMPT'} . "\r\n  " . $CurrentItem{'INFO'},

15. Change to:-

if (length $$pProduct{'OTHER_INFO_PROMPT'} > 0)
{
my $PatchIt = $CurrentItem{'INFO'};
$PatchIt =~ s/%0a/\r\n /ig;
MailOrderLine( "",
$$pProduct{'OTHER_INFO_PROMPT'} . "\r\n  " . $PatchIt,
16. Save the file and then upload your Actinic store.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Having Two Other Info Prompts

It is possible to split the 'Other Info' field in the shopping cart and on the confirmation page into two different fields. This allows your customers to provide much more detailed information with a product. Furthermore, it is possible to only have the extra field created just for specific products, based on the product reference of the product.
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In order to do this, you need to open the file called 'ActinicOrder.pm'. When you have the file open, do a search for 

sub InfoHTMLGenerate

This will bring you into a subroutine within ActinicOrder.pm that controls this functionality. 

Look for the following code under where it says 'CUSTOMISATION BEGIN' code:

if ($sProdref eq "5")

{

my @aValues = split /\|\|\|/, $sValue;

if ($bStatic)


{


$sHTML = join "<BR>", @aValues;


}

else


{


$sHTML = "<INPUT TYPE=TEXT SIZE=\"80\" NAME=\"O_1_$nIndex\" VALUE=\"" . $aValues[0] . "\"><BR>";


$sHTML .= "<INPUT TYPE=TEXT SIZE=\"80\" NAME=\"O_2_$nIndex\" VALUE=\"" . $aValues[1] . "\">";


}

}


Note the word wrap that has occurred on the 11th and 12th line in the code above. These should be long lines without line breaks.

You will see that this code is all preceded with hashes '#'. These comment out the lines and prevent them from being active. In order to make the lines active, remove the '#'s. 

Change the if ($sProdref eq "5") line to reflect the product reference of the product that you want to use the extra fields. For instance, if you wanted the extra field on a product with a reference of 'b16' then change the line to read 

if ($sProdref eq "b16").

You then need to go down to 'sub InfoGetValue' and remove the '#'s from the custom code there, again changing the if ($sProdref eq "5") line as necessary. 

Finally, if you want any specific validation done on the entries in the two fields, you need to go down to 'sub InfoValidate' and uncomment and adjust the code in there. The sample code there will flash up a warning message if the number of characters in either field does not exceed '5'.

Once you have made the required changes you can save the file and upload your store.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Changing The Appearance of the Customer Account Prices

By default, the 'Retail Price' and 'Your Price' prices (that appear when a customer account is logged in) always appear using the same formatting.

If you want the 'Your Price' to have to extra formatting to change its appearance then you need to edit a Perl script called 'ActinicPXMLpm'.

Go into your 'Site1' (or equivalent) folder and locate this file. Open it up in Notepad (or a similar text editor).

Search for '293' in the file. If should highlight the following line:

$sPriceLabel = ACTINIC::GetPhrase(-1, 293, $sPriceLabelText);

Three lines beneath it, locate the following line:

$$sInsideText .= $Response[2];

This is the line you need to edit to change the appearance of the 'Your Price'.

Add formatting similar to the following:

$$sInsideText .= "<span style='color:red;'>" . $Response[2] . "</span>";

Once you have made the required changes you can save the file and upload your store.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Changing the Order of the Shipping Methods

The script ActinicShipping.pl (in the 'ShipControl' subfolder within your site folder) determines the sequence of the shipping classes shown in the checkout.

The script supports 4 sorting sequences, by cost (ascending or descending) and by description (ascending or descending). The default is to sort by cost ascending.

To change the sequence:

1. Locate the file 'ActinicShipping.pl' in the ShipControl folder below the site folder.

2. Open the file in Notepad.

3. Search for ‘CUSTOMISE: Sort’

4. Here you will find the four options, the last three are commented out with a ‘#’ at the start of the line’

5. Insert a ‘#’ at the start of the line of the currently enabled sort option and remove the ‘#’ from the start of the line of the sort option that you wish to enable.

6. Save and Exit

7. Update the site.

Important: If you enable either the ascending or descending alphabetical sort then you will need to replace ‘<=>’ with ‘cmp’.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Changing the Time on the Orders

This section will show you how to change the time that shows on the customer receipt email, and the date that the orders get created. 

Actinic uses GMT for the date on the orders. In order to change this, you need to edit the Perl scripts in several places.

First you need to edit the 'Order Date' function.

Within your site directory, find 'ACTINIC.pm' and open it in a text editor

Find…

sub GetActinicDate

…and then find the following line in this function: 

($sec, $min, $hour, $mday, $mon, $year, $wday, $yday, $isdst) = gmtime(time);

Then adjust the time as required by adding (or subtracting) seconds from the 'time' value. E.g. if you want the time to be displayed as a GMT-5 time then the above line should be modified as 

($sec, $min, $hour, $mday, $mon, $year, $wday, $yday, $isdst) = gmtime(time - 5 * 60 * 60);

If you save your changes and upload your site then all orders will be downloaded by using the adjusted times.

The next step is to change the time on the customer confirmation email.

Locate 'OrderScript.pl' within your site directory and open it in Notepad.

Find…

sub GenerateCustomerMail

… where the same line as above can be found.

Just apply the same changes here and save the file. Please note that there is a line just a few lines below which contains the string 'GMT'. This should also be modified to reflect your real time zone.

In other words the line 

$sDate = $sDatePrompt . sprintf(" %2.2d:%2.2d GMT", $hour, $min);

should be modified to use your time zone. E.g. 

$sDate = $sDatePrompt . sprintf(" %2.2d:%2.2d PST", $hour, $min);

The receipt page already uses the server's local time. If it is not appropriate then this can also be modified by editing 'sub DisplayReceiptPhase' in OrderScript.pl. Just find the line:

($sec, $min, $hour, $mday, $mon, $year, $wday, $yday, $isdst) = localtime(time);

and modify as appropriate. The suggestion is to change this to the same as the one in 'GetActinicDate'. 

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Capturing The Customer's IP Address With The Order

It is possible to capture the customer's IP address with the order and display this information in the 'Misc.' tab of the downloaded order. This can be a useful fraud prevention measure as you can get an idea of where in the world the customer is actually ordering from.

First, go to 'Design | Text | Web Site (cont) | General Information'. Check the 'show' box for the entry 'User Definable 3' and set the 'Prompt' value to 'IP address'

Now change to the 'Design' tab, and in the 'Select Page Type' drop down list select 'Checkout Page 2'. 
Within the page design, click on the 'IP Address' field. You should be in a layout called 'General User Definable 3'.

Replace the entire contents of the layout with:
<input type="hidden" name="GENERALUSERDEFINED" value="<Actinic:Variable Name="GeneralUserDefined"/>" />


Now locate 'OrderScript.pl' within your 'Site1' (or equivalent) folder. Open the file in Notepad.

Search for 'sub DisplayGeneralPhase'

Towards the end of this, about 23 lines down, you will see the line:

$::s_VariableTable{$::VARPREFIX.'GENERALUSERDEFINED'} = ACTINIC::EncodeText2($::g_GeneralInfo{'USERDEFINED'});

Replace it with:

# $::s_VariableTable{$::VARPREFIX.'GENERALUSERDEFINED'} = ACTINIC::EncodeText2($::g_GeneralInfo{'USERDEFINED'});
my $remote_host = $ENV{'REMOTE_HOST'};
my $remote_addr = $ENV{'REMOTE_ADDR'};
if (($remote_host eq $remote_addr) || ($remote_host eq '')) {
   $remote_host = gethostbyaddr(pack('C4', split(/\./, $remote_addr)), 2) || $remote_addr;
}
$::s_VariableTable{$::VARPREFIX.'GENERALUSERDEFINED'} = $remote_addr . '/' . $remote_host;


Save the file and exit Notepad. Update the website through Actinic in the usual way.

After this, when an order is received, the following will be present in the 'Misc' tab:

IP address:
   <remote IP address>/<remote hostname>

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Adding Extra Fields into the Customer Email

General Information Fields

This technique will allow you to put the customer's answer to the question you ask with the 'How did you find our site?', 'What was your reason for buying' and 'User Definable 3' questions into the receipt email that is sent to the customer. These prompts can be edited in 'Design | Text | Web Site (cont) | General Information'.
Please note that this technique will require you to edit the Perl scripts that are used to run the online checkout. Actinic cannot provide support for any programming changes made. If it goes wrong, please revert back to the original 'OrderScript.pl' script, which is found in your 'Original' directory.

Edit OrderScript.pl in 'Notepad'.

Search for 'CUSTOMER_NAME' you will see...

$ACTINIC::B2B->SetXML('CUSTOMER_NAME',$sName);

After this line, insert the following...

#
# GeneralInfo
#
$ACTINIC::B2B->SetXML('HOWFOUND', $::g_GeneralInfo{'HOWFOUND'});
$ACTINIC::B2B->SetXML('WHYBUY', $::g_GeneralInfo{'WHYBUY'});
$ACTINIC::B2B->SetXML('GENUSERDEF', $::g_GeneralInfo{'USERDEFINED'});

Save and exit.

You will now be able to use the following tags in the 'Customer Email' layout (available in the 'Select Page Type' drop down list in the 'Design' tab):

<Actinic:HOWFOUND/>

<Actinic:WHYBUY/>

<Actinic:GENUSERDEF/>

Purchase Order Number

This section will show you how to place your customers' purchase order number into the email they are sent.   

Open 'OrderScript.pl' within your site folder in Notepad.

Find the line:

$ACTINIC::B2B->SetXML('CUSTOMER_NAME',$sName);

You will find this in the sub 'GenerateCustomerMail' function.

Once you have found this line, add the following code underneath:

$ACTINIC::B2B->SetXML('PURCHASEORDERNUMBER', $::g_PaymentInfo{'PONO'});

Once you have made this change, you will be able to use the tag <Actinic:PURCHASEORDERNUMBER/> in the 'Customer Email' layout.
Shipping Method

This will show you how to include the customer’s selected shipping class as a variable in the online receipt.

Open ‘OrderScript.pl’ on Notepad and search for “read the template”.

It will jump to the following lines:

#
# Read the template
#

Just above this, enter the following lines:

#
# Add shipping info
#
$ACTINIC::B2B->SetXML('ShippingClass', $::s_Ship_sShippingDescription);

You can then enter <Actinic:ShippingClass/> into the 'Customer Email' layout wherever you want the shipping method to appear.

Changing the Destination of the 'Continue Shopping' Button

This section will show you how to change the URL for ‘Continue Shopping’ on the ‘View Cart’ page.

Locate 'CartManager.pl' within your 'Site1' folder and open it in 'Notepad' for editing.

Locate 

sub ContinueShopping

A few lines down you will see:

my $sURL = $::Session->GetLastShopPage();

Comment out this line and add a new line so that it reads...

#      my $sURL = $::Session->GetLastShopPage();

       my $sURL = "TargetPage";

Where 'TargetPage' is the URL of the page to be displayed.

Then save the file and upload the store.

Actinic is not able to provide any detailed support for script changes made. If you find that there is a problem, an original copy of the script can be found within the 'Original' folder in your installation. Copy this into your site folder.

Using The Referrer Perl Script

An extra Perl file (normally called rs000001.pl – depending on your script ID) is available in the installer and is automatically uploaded to your web site. It is a way of tracking which sites customers have come through in order to reach your site. It works by creating a text string as a cookie in the customer's browser if they click on a specific type of hyperlink. If the customer places an order, the text string is then included with the order. 

The main uses of this are as follows:

· If you have several links on different websites that point to the same store, you can see how much business comes from each of those links by assigning a different text string to each link.

· If you have several links pointing to your catalogue from different parts of your website, you can see which part of your website is the most popular route for people to go down before arriving at your store by assigning a different text string to each link.

Once an order is downloaded the text string from the cookie appears in a field called sUserDefinedGeneral in the 'Order' table in 'ActinicCatalog.mdb'. By changing the User Definable 3 prompt in 'Design | Text | Web Site (cont) | General Information', to 'Referrer' (but NOT showing it), you can make the text string generated by referrer.pl appear on the Transaction Logs (in the format 'Referrer: <Text String>').

Correct Format for the Call to The Referrer Script

Presuming the following settings:

	URL of your cgi-bin folder 
	http:// www.myserver.com/cgi-bin/

	URL of acatalog directory
	http:// www.myserver.com/acatalog/

	CGI-Script ID
	1

	Path from cgi-bin to the acatalog folder
	../htdocs/acatalog

	Page you want people to land on
	Section_Page.html

	Text string to indicate where people have come from
	123


The call to referrer.pl would be as follows:

http://www.myserver.com/cgi-bin/rs000001.pl?SOURCE=123&DESTINATION=Section%5fPage%2ehtml&PATH=%2e%2e%2fhtdocs%2facatalog&BASEURL=http%3a%2f%2fwww%2emyserver%2ecom%2facatalog%2f 

There are four values you pass to the referrer script:

SOURCE=

The text string to indicate where people have come from.

DESTINATION=
The page in your 'acatalog' folder you want people to land on

PATH=


The path from your cgi-bin folder to your 'acatalog' folder

BASEURL=

The URL of your acatalog directory
The values can be anything as long as they follow the x-www-form-urlencoded standard (%XX where XX is the hex code for the special character like spaces, & , ?, etc.). The text string is limited to 255 characters.

For example, http://www.myserver.com/acatalog/ will appear as: http%3a%2f%2fwww%2emyserver%2ecom%2facatalog%2f

/ becomes %2f

. becomes  %2e

_ becomes %5f

: becomes %3a

Section D: – The Actinic Application
Transferring an Online Store from One PC to Another

In order to make it simple to an entire store from one installation of Actinic to another, there is a built in 'snapshot' feature. A snapshot saves all relevant files and settings into one easily portable file. These 'site files' use an extension of *.acd.

To take a backup of a site go to 'File | Snapshot | Export Site'. This will then guide you through a wizard to help you save all the relevant settings for your currently active site into one file. This can then be implemented onto a second machine by going to 'File | Snapshot | Import Site' on the second machine.

Uploading on One Machine and Downloading on Another

Through checking either one of the 'Allow on this PC' options (under 'Business Settings | Options') you can specify whether a particular machine is used just for 'Catalog Maintenance' or just for 'Order Processing'. This means that one PC can just be used to maintain and upload a store to the web site whilst the other machine can be used solely for order processing from that catalogue. 

How to Add Additional Files to the Installer

Actinic provides the ability for you to include your own files into the Actinic install program at run-time. This is achieved by modifying a configuration file which the Actinic install program reads and acts upon during the installation.

Mechanics

The configuration file is called "ExtraFiles.dat". If you want to supply new templates or images, or indeed any sort of file, you must create a file called "ExtraFiles.dat" and place it in the same directory as the Actinic install program.

This can be on a CD, a hard disk, a network drive or the last disk of a floppy disk set. For technical reasons the install program installs a default copy of the file, which the install program looks for. If present it is copied into the Actinic installation directory, overwriting the original file.

"ExtraFiles.dat" is a text file and has a very specific structure.

Delimiter command

The first line of the file must be of the form:

delimiter=,
	delimiter=
	Identifies the command to the install program.

	,
	Any single ASCII character and is used to define the field separator in subsequent commands.


Notes: No other field in the configuration file can contain the delimiter. The preferred delimiter in the following instructions is a comma.

The remainder of the configuration file contains one of more "message" or "copy" commands.

Message command

This command instructs the install program to display a message to the user. The message window contains the message text and an OK button. It has the following syntax:

message,messagetext

	message
	Identifies the command to the install program.

	,
	The delimiter that separates the command from the text.

	messagetext
	The ASCII text that will be displayed in a message box. It does not need to be enclosed in quotes. The install program reads the text until the end of the line or until its buffer is full.


Notes:

· If the syntax is not correct then an error is generated.

· If an error is generated, a message will be displayed instructing the person installing Actinic to contact their supplier. No further commands will be read from the configuration file. The Actinic install program will proceed to completion.

· Each message to the user must be via a separate message command.

Copy command
The "copy" command instructs the install program to copy a file from the installation disk to anywhere within the Actinic installation directory.

This restriction is so that only the Actinic files are affected and so that system files cannot be changed. It has the following syntax:

copy,source,destination

	copy 
	Identifies the command to the install program.

	,
	The delimiter between the command and the first field.

	source
	The first field. It specifies the file to copy. It can also specify the location of the file relative to the install program, i.e. in a subdirectory.

	,
	The delimiter between the first field and the second field.

	destination
	The second field. It specifies, and must include, the name of the copied file. It can also specify the location of the copied file relative to the installation directory, i.e. in a subdirectory. If no directory is specified, the file is copied into the Actinic installation directory.


Notes:

· If the syntax is not correct then an error is generated.

· If the source file cannot be found then an error is generated.

· If the copy command fails to copy then an error is generated.

· If an error is generated, a message will be displayed instructing the person installing Actinic to contact their supplier. No further commands will be read from the configuration file. The Actinic install program will proceed to completion.

· Each file to copy must be individually specified.

· The destination directory, if supplied, will be created if it does not already exist.

· If a file already exists with the same name as that specified in the destination field, it will be overwritten without warning.

Example

In the following example, a comma is defined as the field delimiter. The message "A number of extra files will now be installed." is displayed to the user. When they hit the OK button two files are copied. The first copies "Act_ProductBody.html" from the same directory as the install program to the Actinic "Original" directory, overwriting the existing file. The second copies "background1.gif" from a directory on the install disk called "sample2" to a directory called "webhostsample" in the Actinic root installation directory. If the "webhostsample" directory does not exist, it will be created. The third example copies a new 'ActinicCatalog' database (containing all the Actinic settings) into the 'Site1' directory, so that when the application is started, it will start with some settings automatically in place.  

delimiter=,

message,A number of extra files will now be installed.

copy,Act_ProductBody.html,Original\Act_ProductBody.html

copy,sample2\background1.gif,webhostsample\background1.gif

copy,ActinicCatalog.mdb,Sites\Site1\ActinicCatalog.mdb

Creating a Custom Quick Start Tutorial
This is a useful technique that allows you to create your own customised user interface to the Actinic application.

The files that control the Quick Start Tutorial (also known as the 'Navigator') can be found in the 'Formats\NavigatorSkins' directory. Within this directory is a file called 'skins.ini' that contains a reference to the directory where the current set of Navigator files are located. If you look within this directory, you will see a set of HTML files, bitmap images, sound files, etc. These files collectively are known as the 'skin' and they control the appearance and functionality of a Quick Start Tutorial. The most important file within this is called 'skin.ini', which contains information about the shape of the Quick Start Tutorial and the bitmap images that are to be used.

A Quick Start Tutorial is made up of one or more 'panels'. A panel will contain active areas (known as 'hotspots') that change appearance when you move your mouse over them. When you click on one of these 'hotspots' a program function will be activated.

The way a Quick Start Tutorial works is that the panel you see at first is called the 'passive' bitmap, this bitmap works in conjunction with an HTML file that contains hotspot information about which areas of this panel are the active areas. When you move your mouse over an active area, Actinic will flip that portion of the bitmap from the passive image to the active image. If a particular software feature is disabled for some reason, then Actinic will flip that area of the bitmap from the passive image to the disabled image. 

The navigator also has the ability to display a text area to the customer, which can contain extra help, license terms etc. 

'Skin.ini'

'Skin.ini' contains the information about the passive, disabled and active bitmaps and the HTML file that is used for each panel. However, it begins with defining general information about the Navigator:

	Command
	Description

	[Skin]
	marks the start of the skin description

	Name
	the skin name. This could be anything.

	Panels
	the number of panels in the skin

	Shape
	(Optional) Use an HTML <AREA> tag to fix the Navigator window size and shape. Rectangular, circular or polygonal areas can be defined. If this tag is not present then the Navigator will size itself to the first panel it encounters. All Navigator images must be the same size and shape. 

	RolledUpBitmap
	(Optional)   A 'roll-up' image is the image that the navigator changes to when it has been idle for a while. Although the actual image specified must be the same size as the other bitmap images used in the Navigator, the <AREA> tag below is used to 'cut-out' which portion of the image will be visible to the users. 

	RolledUpShape 
	(Optional) Use an <AREA> tag to set the size and shape of the rolled-up image. You will probably need to use a web design application to create this information (see below). 

	ExtraTextBackgroundColour
	The background colour of the text area in RGB format (e.g. red would be '255 0 0')

	ExtraTextLineColour
	The line colour around the text area in RGB format (e.g. green would be '0 255 0')

	ExtraTextTextColour
	The colour used for the text in RGB format (e.g. blue would be '0 0 255')

	ExtraTextLineWidth
	The thickness of the line around the text area, in pixels

	ExtraTextFontName
	The font the text will appear in

	ExtraTextFontSize
	The size of the font, as a point size


Example code for this part of the file could be:

[Skin]

Name=My new Navigator

Panels=4

Shape=<area shape="rect" coords="0,0,500,400">

RolledUpBitmap="rollup.bmp"

RolledUpShape=<AREA SHAPE=POLY COORDS="230,125,236,125,
300,124,301,186,228,186,228,165,221,157,221,136,223,130,230,125,230,125"

ExtraTextBackgroundColour=254 231 40

ExtraTextLineColour=12 250 0

ExtraTextTextColour=40 254 65

ExtraTextLineWidth=1

ExtraTextFontName=Arial

ExtraTextFontSize=14

Underneath this, each panel of the Navigator is defined in turn. 

	Command
	Description

	[Panel0], [Panel1], [Panel2] etc.
	Marks the start of a panel description

	Name
	The panel name

	PassiveImage
	An image file that shows all the buttons in passive mode (when the mouse is not over the buttons) 

	ActiveImage
	An image file that contains all the buttons in active mode (when the mouse is over the buttons)

	DisabledImage
	An image file that contains all the buttons in disabled mode (when the feature is not available)

	Hotspots
	The name of the HTML file that defines the hotspot layout of the panel (see below)

	Music
	(Optional) The sound file to be played, repeatedly, whilst the panel is in view

	Sound
	(Optional) The sound file to be played once when the panel opens


Example code for a panel definition is shown below:

[Panel1]

Name=Products

PassiveImage="products_passive.bmp"

ActiveImage="products_active.bmp"

DisabledImage="products_disabled.bmp"

Hotspots="products.htm"

The HTML file used in the 'Hotspots' field sets the co-ordinates of the hotspots in the panel image file, using image maps. These hotspot definitions should match the location of the appropriate button icon on the panel. The image below demonstrates how hotspots can be edited using an application such as Macromedia Dreamweaver.
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You can include any of the following parameters within the <AREA….> HTML tag for defining the hotspot.

	SHAPE=
	The shape of the hotspot. This can be 'POLY', 'RECT' or 'CIRCLE'

	COORDS=
	The co-ordinates of the hotspot

	HREF=
	The action triggered by clicking on the hotspot. Use one of the following instructions:

HREF="COMMAND XXXXX" - a pre-defined command to activate a menu option. You can find these in the table at the end of this section.

HREF="ACTION PROPERTIES XXXXX" - use this to open up a specific tab within 'Business Settings'. The full list of options for this is available below.

HREF="ACTION OPTIONS XXXXX"- use this to open up a specific tab within 'Design Options'. The full list of options for this is available below.

HREF="ACTION PRINT XXXXX"- use this print a specific report. The full list of options for this is available below.

HREF="PANEL X" - jump to a different panel

HREF="DISABLED"  - nothing will happen when you click on it

HREF="EXIT"  - close the navigator

	Shortcut=
	Define a new keyboard shortcut command that will activate the current navigator function. 

Shortcut="Ctrl+D" 

Shortcut="Ctrl + Shift + R" 

Note that it does not matter about spaces within the quotes.

	ALT=
	Text to appear when you move your mouse over the hotspot.

	SoundOver=
	Sound played when the mouse moves over a hot spot

	SoundClick=
	Sound played when the mouse clicks on a hot spot

	ExtraText=
	The text to be shown in the text area

	TextLocation=
	The coordinates of the rectangle that makes up the text area

	MODELESS
	Use this phrase in the tag to stop the Navigator firing up again automatically when the software has completed the designated operation.


An example HTML file could be as follows:

  <area shape=rect coords="121,206,224,246" href="COMMAND 61018" alt="Check your stock levels">

  <area shape=rect coords="122,159,224,198" href="COMMAND 61001" alt="Import products &amp; sections from an external file">

  <area shape=rect coords="122,111,223,150" ExtraText="This is a text test" TextLocation="10,10,310,210" alt="Get some help with adding products and sections">

  <area shape=poly coords="389,128,417,100,446,129,446,159,467,159,467,197,368,197,368,160,392,160" href="COMMAND 61027" alt="Update your online store with the latest changes">

  <area shape=rect coords="256,158,357,197" href="COMMAND 61026" alt="Check the look of your store without connecting to the Internet">

  <area shape=rect coords="532,11,574,31" href="PANEL 2" alt="Back to the previous panel">

  <area shape=rect coords="578,10,599,30" href="EXIT" alt="Close the Navigator">

Once you have created your new Navigator skins, you can copy then into an Actinic installation by including them on a CD as described in 'Adding Additional Files to the Installer' above.

Navigator Commands for Menu Items

	File Menu
	
	
	Design Menu
	

	Sites...
	61000
	
	Themes 
	61023

	External Links...          
	61006
	
	Colors
	61098

	Import...                  
	61001
	
	Options - see ACTION OPTIONS below
	

	Export...                  
	61103
	
	Text - see ACTION OPTIONS below
	

	Snapshot... Submenu
	
	
	Web Menu 
	

	    Export Site
	61002
	
	Offline Page Preview 
	61075

	    Import Site...             
	61003
	
	Offline Preview    
	61025

	    Export Themes...           
	61004
	
	Update Website     
	61026

	    Import Themes...           
	61005
	
	Refresh Website            
	61027

	Print Setup...             
	0xE106
	
	Retrieve Orders    
	61028

	Exit                       
	0xE141
	
	Send Emails
	61096

	Edit Menu
	
	
	List Emails Submenu
	

	New Page
	61090
	
	    Failed
	61108

	New Fragment
	61091
	
	    All
	61107

	New Section        
	61009
	
	Configure Web Site Details...                                                    
	61029

	New Sub-section
	61010
	
	Housekeeping Menu
	

	New Product        
	61008
	
	Upgrade...                 
	61038

	New Component      
	61056
	
	Purge Submenu
	

	New Attribute      
	61057
	
	    Purge Orders
	61039

	New Choice         
	61058
	
	    Purge Emails
	61104

	Find           (for Catalog View)
	61013
	
	    Purge Catalog
	61040

	Find Next              
	61014
	
	    Purge Customer Accounts
	61041

	View Menu
	
	
	    Purge Adjustments
	61074

	Business Settings...       
	61015
	
	Recover...                 
	61042

	Customer Accounts...       
	61016
	
	Compact Databases...       
	61043

	Price Schedules...       
	61017
	
	Security...                
	61044

	Stock Levels...       
	61018
	
	Advanced Menu
	

	Search Settings...         
	61019
	
	Template Manager...      
	61030

	Catalog             
	61020
	
	Define Custom Properties... 
	61031

	Orders             
	61021
	
	Additional Files...        
	61032

	Refresh Product Links  
	61023
	
	Locations...              
	61090

	Navigator          
	61073
	
	Generate Scripts           
	61033

	Toolbar
	0xE800
	
	Generate Web Site          
	61034

	Status Bar
	0xE801
	
	Send Files                 
	61035

	Reports Menu
	
	
	Network Setup...           
	61036

	Report Selection…
	61100
	
	Help Menu 
	

	Outstanding Exports
	61101
	
	Help Topics            
	0xE143

	
	
	
	Online Support             
	61054

	
	
	
	About Catalog...           
	0xE140


Navigator Commands for Tabs

	Business Settings

HREF="ACTION PROPERTIES n"
	
	Design | Text

HREF="ACTION OPTIONS n"

	Company/Contact tab
	20
	
	Checkout prompts
	1

	Options Tab
	21
	
	Advanced:Language prompts
	2

	Ordering Tab
	22
	
	Advanced:Plugin prompts
	15

	Payment tab
	23
	
	Business to Business prompts
	3

	Tax tab
	24
	
	Catalog Reports prompts
	4

	Shipping and Handling tab
	25
	
	Order Processing Reports prompts
	5

	Terms and Conditions tab
	26
	
	Sales Reports prompts
	6

	
	
	
	Design | Options

HREF="ACTION OPTIONS n"

	
	
	
	Defaults
	10

	
	
	
	Optiona
	11

	
	
	
	Brochure
	12

	
	
	
	Sections
	13

	
	
	
	Navigation
	14


Navigator Commands for Reports

	Reports

HREF="ACTION PRINT n"
	
	Reports

HREF="ACTION PRINT n"

	Outstanding Packing Lists
	1
	
	Catalog Summary
	19

	Outstanding Products
	2
	
	Catalog Detail
	20

	Oustanding Invoices
	3
	
	Price List Summary
	21

	Export Outstanding Labels
	4
	
	Price List Detail
	22

	Outstanding Data Entry
	5
	
	Stock Level Suspended
	23

	Outstanding Credit Card Schedule
	6
	
	Stock Level Warning
	24

	Outstanding Exports
	12
	
	Stock Level Enabled
	25

	Sales Analysis
	15
	
	Stock Level All
	26

	Customer Account Transactions
	16
	
	
	

	Transactions
	17
	
	
	

	Referrer Transactions
	18
	
	
	


Adding Your Own Reports into Actinic's Built-in List

First, you need to save your custom report in the Actinic installation directory.

Next, you need to edit the file called ‘Reports.ini’, which can be found within the site working folder (normally ‘Sites\Site1’). Edit the code at the bottom to look something like the following:

[Reports]
TransactionsSummaryByReferrer="Transaction Summary by Referrer"

[TransactionsSummaryByReferrer]
ReportName=ME_TransByRefV6.rpt
FromDate="Select &From:"
ToDate="Select &To:"
TestedDate="orders.date ordered"
PromptID=4
PromptPhase=1
SelectionFormula=
ExtraConditions="{Orders.bOrderIsDeleted} = false and {Orders.nPaymentStatus} <> 8 and {Orders.nPaymentStatus}>0"

Explained :

[Reports] : 

A section that lists the user defined reports and references a section 



giving the report details.

[TransactionsSummaryByReferrer]: the section for this report

ReportName:

the file name of the report, must be in the main catalog directory

FromDate:

the prompt for the from date

ToDate:


the prompt for the to date

TestedDate:

the crystal format date field to test

PromptID:

prompt id for report string

PromptPhase:

prompt phase for report string

SelectionFormula

selection formula for the report

ExtraConditions

extra where clause conditions

Unfortunately, you can't add a report to work with the currently selected catalog items or orders.

Advanced Options For Mailing Lists

'Marketing | Mailing Lists' allows you to filter your customer data by specific criteria to generate mailing lists. Here are some advanced tips for filtering customer data for Actinic Business users:
List All Customers Who Have Bought Product X But Not Product Y

Within the tree in the 'Select Products' tab, select your product X products – i.e. the products that your desired customers have bought.

Within the 'Product Search' tab, select 'Exclude matching products' and then enter the product reference of product Y (the products that your desired customers haven't bought) into the 'Reference' field.

You can now set up your 'Main' tab to search for particular date ranges and click 'Preview list' to check what customers have been selected.

Printing Packing Labels For Today's New Orders

Within the 'Main' tab, set the date fields to only contain today's date. You might also want to set the 'Order Status' to 'Complete'.

Go to the 'Options' tab and under 'Unique Field' select 'Order Number'. 

Now go to the 'Preview' tab and click the 'Print' button. Under 'Type' select 'Label Sheets' and then select how many labels per sheet you want to use. Click 'Preview' to check your data.

Section E:
Help With Hosting

Running Multiple Actinic Stores On One Website

You can run as many sites you want on the same web server as long as 
a) Each site is using a different 'CGI-Script ID'
b) Each site is uploading to a different 'acatalog' folder.
Giving Each Site a Different 'CGI-Script ID' 

The ID is set in 'Web | Network Setup' in the a 'CGI-Script ID Number' field. Give your first site an ID of '1', the second an ID of '2' etc.
Uploading Each Site To A Different 'acatalog' Folder
Actinic uploads to a folder called 'acatalog' on the web site. Where this folder is located is up to you. For example, for your first site you may put the 'acatalog' folder in a sub-folder on the server called 'site1' and then upload the second store to an 'acatalog' folder called 'site2'.

In which case you use the settings similar to the following in 'Web | Network Setup' for the first site...

Catalog URL: http://your.URL/site1/acatalog/
Path From CGI-BIN to acatalog Folder: ../htdocs/site1/acatalog/

And then for the second site....

Catalog URL: http://your.URL/site2/acatalog/
Path From CGI-BIN to acatalog Folder: ../htdocs/site2/acatalog/
Specifications Required for Actinic to Run

Actinic installs on a website by sending certain files to the website via FTP. The Actinic scripts do not have very complex requirements: all the user needs is a web hosting account that allows them to run CGI scripts written in Perl.
The specific requirements for Actinic to run successfully are as follows:

1. A UNIX or Windows NT system running a web server. 

2. The web server must support POSTs and GETs to CGI scripts implemented in Perl

3. Perl 5.004 or greater must be installed on the server

4. The user must have access to a cgi-bin directory (or any directory that allows them to execute CGI scripts).

5. The user must have access to a web server document directory (a directory from which the web server distributes files).  This directory is referred to as the web root directory.

6. The CGI scripts must have access to the web root directory (the directory from #5).

7. The effective user ID of the CGI scripts when they are executed via the web browser must have read and write access to the web root directory (from #5).

8. The user ID of the web server must have read access to the web root directory (from #5) and read/execute access to the cgi-bin directory (from #4).

9. The server must execute the CGI scripts in the directory in which they are installed.  (There has never been a problem with UNIX servers or third party NT web servers violating this requirement, but Microsoft's IIS breaks this rule unless the cgi-bin directories are located in a particular directory specified by IIS.)

10. The user must have FTP access to the server, or they must be running in Actinic Freetrial* mode, or they must do manual installs**.

11. If the user plans to FTP files to the server, their FTP account must be able to read, write, and delete files in the cgi-bin directory and the web root directory (from #5).  They must also be able to create sub-directories in the catalog directory. Users on UNIX systems must also be able to change the file and directory permissions.

12. If the user plans to run in Actinic Freetrial mode, they must have an account with an ISP that supports Actinic Freetrial.

13. If the user plans to perform manual installs, they must have some method of transporting and installing the files on the web server.

14. A SMTP server must be available to the CGI scripts if the user would like to be notified via email when new orders arrive.

15. If the user plans to use Actinic's Java applet to capture and encrypt credit card information at the final stage of the ordering process, the Java applet archive directory must be accessible via the web server that executes the CGI scripts. 

16. If the user plans to use SSL to secure the credit card details of their customers, the catalog files (files in the acatalog directory created within the acatalog directory from #5) must be accessible to the secure server.

* Actinic Freetrial is a version of Actinic which comes preconfigured to be hosted on a specific server. It does not require FTP as all the cgi and java files are already loaded on the server. It is used for Actinic's trial hosting.

** A Manual Install is the process by which the cgi and java files, that are normally transmitted to the website via FTP, are generated on the desktop computer. The files can then be transmitted to the website via another method. This is normally used when a user does not have FTP access to their site.

Web Space Required by Actinic 

A formula for estimating the amount of space you will need at the web site for your catalogue is as follows:

if p = number of products in the store

and s = number of sections you are planning on using

then

Size of store (in MB) = (0.85p + 15.55s)/1000 + 0.8

The above is based on the Business theme, with compacted HTML and an average of 30 words per full description. This figure includes the Perl and Java etc. but does not include images (which can often form the bulk of the space taken up on a website.)

Disclaimer: These figures are based only on rough estimates and should be accepted as such.
Permissions required by Actinic Ecommerce 

UNIX Servers

If the customer is running in normal mode, the minimum permissions required are:

'cgi-bin' directory

· 755

'acatalog' directory

· The FTP user ID must have full permissions (7)

· The effective user ID of the CGI scripts must have read/write permission

· The effective user ID of the Web server must have read permissions. Depending on the set up, the permissions could be 700, 760, 764, 746, or 706.  700 and 760 are probably the most common. 

If you encounter problems with permissions when trying to upload your store for the first time, try setting the permissions on the effective user ID of the web server to '777'. Once your store is uploaded, progressively tighten up the permissions on the web server to one of the settings recommended above, or until your store no longer functions. 

NT Servers

See Section G , below. 

Actinic's Online Components

The components that Actinic Ecommerce uploads to the Internet are detailed below.

	Directory
	Files
	Extension

	/cgi-bin
	Perl Files
	.pl

	/acatalog
	Web Pages
	.html

	
	Images specified within the application
	.gif / .jpg

	
	Shipping/tax/login/search config. files
	.fil

	
	Binary files accessed by Perl when adding a product to the shopping cart etc.
	.cat

	
	Unique order number generation files
	.num

	
	E-mail templates
	.txt

	
	'encrypt' files containing encryption key data
	.cab / .zip

	/acatalog/COM/Actinic/Catalog
	Java Archives
	.class


Uploading Without FTP Access

Actinic uploads its files via FTP. If a user is not able to have FTP access to his or her cgi-bin directory, it is possible to work around this by having the user manually generate the files that are normally transmitted to the website via FTP. The rest of the site can then be transmitted via HTTP. These can then be passed onto the ISP to be installed on the web site by the ISP.

In order to manually generate the files required, the user must carry out the following:

1. Start Actinic 

2. Set all the Network Preferences (found at Web | Network Setup) except the FTP details. (Refer to the main help file if required.)

3. Go to 'Advanced | Generate Scripts'. Follow the directions to install the files that are normally FTPed to your web site..

To update your web site installation, 

Transfer the CGI scripts to the CGI-BIN on your web server: 



nq000001.pl



ms000001.pl



ca000001.pl



os000001.pl



bb000001.pl



ss000001.pl



sh000001.pl



md000001.pl



al000001.pm



ad000001.pm



as000001.pm



di000001.pm



ae000001.pm



ao000001.pm

Create the Actinic Ecommerce web site directory ('acatalog')

Place the Java applet archive files in the Actinic Ecommerce web site directory: 



encrypt.zip



encrypt.cab 

Create a subdirectory tree (COM/Actinic/Catalog) off of your catalog web site directory and place the loose Java applet class files in it:


EA.class



BOS.class



OB.class



OR.class



R.class



TD.class



S.class



FI.class



IC.class

If the web server is a UNIX server, be sure to set the proper executable permissions on the CGI scripts.  The CGI scripts can be found in C:\Program Files\Actinic v8\Sites\Site1\.  The applet archives and loose classes can be found in C:\Program Files\Actinic v8\.

Once the files are in place, the user needs to use the 'Web | Update Website' menu option to complete the upload process.

If the user changes their network preferences or selects the 'Web | Refresh Website' menu option, Actinic will regenerate all of the "base" files and it will appear to Actinic that these files need to be uploaded, even if the vendor did a "manual" install immediately before the refresh. This is not a serious problem and it can be worked around. The correct operation should be as follows:

1. Change some network settings or prepare for a refresh.

2. Select the 'Web | Generate Scripts' menu option.

3. Manually install the base files at the web site if they have changed at all.

4. Select either the 'Web | Update Website' menu option or the 'Web | Refresh Website' menu option.

5. A warning will be shown, explaining that the base files need to be uploaded. Click the OK button.

6. Let the upload complete.

7. Select the 'Web | Generate Scripts' menu option. Again but don't transfer any files to the web site.

8. Further uploads will complete without the warning from step e.

Using Actinic with a Firewall

Actinic is composed of two parts:

1) An application that runs on a PC that is the part that the merchant operates.  This is the 'PC client' 

2) Online components (written in Perl) that run on a web server.

If there is a firewall between the PC client and the web server, the following must be allowed:

· HTTP

· FTP

· HTTPS (when security has been set to "SSL")

Actinic uses the standard ports 80 for HTTP, 21 for FTP.

Also, SMTP communications take place between the web server and the selected SMTP server.  The SMTP server will usually be on the same physical server, but if communication is via a firewall it must allow SMTP.  Obviously, the SMTP server must be allowed to send emails to the general Internet.

Customers will use a browser to buy from the online shop. If there is a firewall between the browser and the web server, the following must be allowed:

· HTTP

· HTTPS (when security has been set to "SSL")

· Java applet (when security has been set to "Actinic inbuilt encryption")

Actinic uses the standard port 80 for HTTP.

Section F: Installing a Standalone Demo on a PC

These instructions will allow you to turn your PC into a web server, in order to be able to upload an Actinic store for testing/demonstration purposes - without connecting to the Internet.

Note: This will only work for a user on a PC with Administrative rights.
Downloading The Required Components

There are three components that are required are:

· Perl Interpreter - to execute the Actinic Perl scripts

· Web Server - so you can connect to folders on your PC with an http address

· FTP Server - so you can log into folders on your PC via FTP, with a username and password 

Here is where you can get hold of these three components (instructions are correct as of 06/02/04):

Perl Interpreter

	Application:
	ActivePerl

	Preferred Version:
	5.8.8.817 (or higher)

	URL:
	http://www.activestate.com/

	Directions:
	In the top menus, go to ‘Languages | ActivePerl Family’ and then click ‘Download’. Then click on 'ActivePerl'

You will need to register with your name, email address and company name before you download.

Download the Windows MSI package.


Web Server

	Application:
	Apache HTTP Server

	Preferred Version:
	2.2.3

	URL:
	http://httpd.apache.org/

	Directions:
	Click on the 'Download > From a Mirror' link at the left hand side.
Scroll down to where it says 'Apache 2.2.3 is the best available version' and under it, click the link where it says 'Win32 Binary (MSI Installer)'. Note that the best available version may be higher than 2.2.3 The file will be called something like 'apache_2.2.3-win32-x86-no_ssl.msi'.


FTP Server

	Application:
	War FTP Daemon

	Version:
	1.82

	URL:
	http://www.warftp.org/

	Directions:
	Click on the 'Download' link.
Scroll right to the bottom of the page to where it says 'War FTP Daemon 1.80 (Current)'
Ignore where it talks about beta versions, and just click the 'warftpd-1.82-00-RC2-i386.exe' link to download the file.


Installation Instructions

ActivePerl

Run 'ActivePerl-*.*.*.*.msi' (different versions have different filenames in place of the asterisks). A successful installation can be achieved by going with all the default settings in the installer (although you can click 'Browse' when required to install on a drive other than C:\).

Note: You need to restart the computer before Perl will work properly.

Apache HTTP Server

Run 'apache_2.0.59-win32-x86-no_ssl.exe' (or whatever version you have downloaded).

During installation, set both the 'server name' and 'web site name' to 'localhost'. For the administrator email, just put 'anyone@localhost'.

IMPORTANT: The default installation directory should be changed to C:\Apache2 (rather than C:\Program Files\Apache Group). Naturally, you can install on D:\ rather than C:\ if required.

If you are using Windows NT/2000/XP then Apache will start right away after installation. There is a 'Service Manager' icon appearing in the system tray next to the clock that you can use to monitor Apache.

War FTP Daemon

Run 'warftpd-1.82-00-RC2-i386.exe'. It will extract the installation files to a temporary folder, and you can click 'INSTALL' to install the application. 

You can just accept the default installation directory (or change it to install on D:\ rather than C:\ if required).

A configuration wizard will then start. Select that you want a 'New Installation' and then just accept the next three defaults. 

IMPORTANT: When the install wizard asks you to enter a 'root file system', the click the browse '…' button and browse to 'C:\Apache2\htdocs'. Click 'Next >' when ready. 

Accept the next default and then enter a 'SYSADMIN' password for the FTP Manager. Remember to make a note of the password you enter, as you will need it when you first start the server. Click 'Next>'.

Don't worry about entering an email address, and then click 'Next>' twice until you see a green 'Go!' and you are ready to start the installation.

War FTP Daemon will then configure itself and start. You can access it at any time by clicking the yellow triangle in the system tray (next to the clock).

Configuration

Apache 

Under the 'C:\Apache2\htdocs' directory create a directory called 'cgi-bin'.

Then, open 'C:\Apache2\conf\httpd.conf' in Notepad and make the following changes:

Locate the line:

ScriptAlias /cgi-bin/ "C:/Apache2/cgi-bin/"
Just search for 'cgi-bin' to find the required line.

Change it to read:

ScriptAlias /cgi-bin/ "C:/Apache2/htdocs/cgi-bin/"

A few lines later you will need to change:

<Directory "C:/Apache2/cgi-bin">

To read:

<Directory "C:/Apache2/htdocs/cgi-bin">

Naturally, substitute D:\ for C:\ if required.

Now close the file and save it.

Please note that any changes made to httpd.conf will not be implemented until Apache has been started/restarted.

If you are using Windows NT/2000/XP then Apache will already be running so you need to go to the 'Apache Service Manager' icon in the system tray (next to the clock) to restart it.

War-FTP Configuration

Open the War FTP Manager by double-clicking on the yellow icon in the system tray. You may need to log in.

Click the 'UserManager' icon on the toolbar (by clicking the folder icon with the face on it).

Click on 'System' (in the top-left). Then in the right hand panel, activate FTP Login access by double-clicking on 'FTP Login Access' in the box in the middle of the right-hand panel.

Next, select the 'FTP' tab (at the bottom) and click on the '+' next to 'Security'. Then click on 'File Access'. Some file paths will appear in a list at the top of the panel.

Click on the top file path that reads 'C:\Apache2\htdocs'. 

In the check boxes underneath, make sure the following are selected:

Recursive, Free, Create, Remove, List (DIR), Read, Write, Delete

This is shown below:
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Next, right click in the list of file paths and select 'New'. 

Enter 'C:\Apache2\htdocs\cgi-bin' (without the quotes) in the 'Path' field. Then, select the 'Freeze the mount point' box and in the 'Mount Point' field, enter '/cgi-bin'.
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Click 'OK'. Then in the boxes underneath select:

Read, Write, Delete, Execute

This is shown below:
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Next, go back to the left-hand panel and click the '+' next to 'System'. Then right-click on 'User' and select 'Add User'.

Enter a username of 'demo' and click 'OK'. Then enter a password (and confirm it) and click 'OK'.

Click 'Close' and then close the War FTP Manager.

Actinic Network Settings

Start Actinic and go to 'Web | Network Setup'. If it says 'Actinic Host Mode' at the top then click 'Convert' and 'Yes'. Enter the following details in the fields provided.

	Server details:
	

	Catalog URL: 
	http://localhost/acatalog/

	CGI-BIN URL: 
	http://localhost/cgi-bin/

	Codebase: 
	./

	Path from CGI-BIN to Catalog Directory: 
	../acatalog

	
	

	Common Settings
	

	Script ID Number: 
	1

	Extension: 
	.pl

	Mail (SMTP) Host: 
	[leave blank]

	Web Site URL: 
	http://localhost/

	Path to Perl: 
	C:\Perl\bin\perl.exe (or D:\Perl\bin\perl.exe)

	
	

	FTP Details:
	

	Server Host:
	localhost

	Username: 
	demo (or username created in War-FTP)

	Password: 
	Whatever was setup in War-FTP

	Path to CGI-BIN: 
	cgi-bin/


Testing if it Works

Go to Actinic and go to 'Web | Refresh Website'. This will upload all the necessary files. Once it has completed, you should now be able to browse to your home page:

http://localhost/acatalog/

Troubleshooting

Check That Perl Is Installed 

To check that Perl is installed on your PC, in a command window type:

C:\>perl –v

Sample output from a command window check that Perl is installed and will run:
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Also in the command window check the path to Perl by typing:

C:\>path
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The correct path is: C:\Perl\bin, as above.

Check Apache

Open up a browser and browse to http://localhost/ and the Apache Welcome page should appear. The page should read "It HAS Worked! The Apache Web Server is Installed on this Web Site!". If it does not appear, check your installation of Apache by repeating the steps listed earlier in this document.

Check War-ftpd

Open up War-ftpd and check the permissions settings are identical to the screen shots earlier in this document. 

Access Denied Errors

If you are getting 'Access Denied' Errors on upload, then check the boxes in War-FTP are ticked correctly, as described earlier in this document, and also check that War-FTPd is online.

Check Perl Scripts

To check that the path to the perl scripts is correct, and that they will run, in the browser, browse to http://localhost/cgi-bin/nq000001.pl. If a page with nothing but the words 'Script Error' (in red) appear then the upload has been successful.

Manual Check of War-ftpd

To check that War-ftpd is working and is providing access to the cgi-bin directory, make sure War-ftpd is online, and then in a Command Window type:

ftp localhost

Then connect as your demo user, entering your password when prompted. Next enter the following commands:

cd cgi-bin

dir

If it shows you a list of files, then the permissions are set correctly. 

Perl Association

To check the association of the Perl file extension (.pl) in Windows NT the following registry key needs to be checked:

LocalMachine\SYSTEM\CurrentControlSet\Services\W3SVC\Parameters\Script Map

The association should look like the following:
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The association should be:

Name

Type

Data

.pl 

REG_SZ
C:\Perl\bin\Perl.exe %s %s

Note: The "s" of %s %s are both lowercase.

Section G: IIS5 Server Setup

Host Headers

Host headers are a mechanism where more than one domain name can be hosted from a single IP Address.

Use the IIS MMC to create a host header name for each web site to be hosted on the IP Address.

The host header name has to be registered with the appropriate name resolution system. 

If the computer is on an intranet (a private LAN that uses Internet technology), register it with the intranet's name resolution system, such as the Windows Internet Name Service (WINS).

If the computer is on the Internet, register the host header name with the Domain Name System (DNS), which is administered by InterNic. 

If you are using a name that is not a registered DNS name you can add to the systems hosts file, found at:

C:\WINNT\System32\drivers\etc\hosts

Note: This mechanism only works for the system(s) with the host header entry in their hosts file.
Vocabulary

	Term
	Definition

	DNS
	Domain Name System is a method for resolving IP addresses to/from host names. DNS root servers are owned and maintained by the InterNIC for the Internet.

	Virtual directory alias
	A virtual directory alias is a name that clients use when referring to your virtual directory. For example, in the address http://www.actinic.com/cgi-bin, cgi-bin is a virtual directory.

	Virtual Web site
	A virtual Web site provides the appearance that two or more sites are different, even though they exist on the same Internet server.


Setup of Catalog Web Site

Open the IIS MMC and expand the pane view of the server structure.

Right click on the server and select 'New | Web Site':
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The Web Site Creation Wizard appears:

[image: image141.png]Creation Wizard

compuer.

Click Next to continue.

Welcome to the Web Site

Neit>

This wizard wil help you creste a new Wb sie on tis

Cancel





Click the Next> button.

Enter the Description of the Web Site:
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Click the Next> button.

Select the IP Address to use for this Web Site from the drop-down list.  Change the Port Number if a port other than 80 is to be used.  If Host Headers are to be used, enter the Host Header for this site:
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Click the Next> button.

Click on the Browse… button and browse to the Home Directory to be used for this Web Site:
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Click the OK button.
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Click the Next> button.

Select the following permissions:
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Click the Next> button.
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Click the Finish button.

CGI-BIN Directory

The cgi-bin directory has to exist on two levels:

1. The physical level – actually on the hard disk.

2. The Virtual level – within IIS.

CGI-BIN Physical Directory Creation

A cgi-bin directory has to be created before it can be an IIS “Virtual Directory”.  

Open up Windows Explorer and drill down to the Web Site “Home” directory:
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Right click on the directory and in the popup menu select:  New | Folder 

[image: image149.png]C\InetpublwmwiootCatalogsite

x

Name

{2 bentaa
2 Code

= e

[eaibin





Enter cgi-bin as the directory name.

CGI-BIN Virtual Directory Creation

For Catalog to be able to access the perl script files on the host server, a cgi-bin (created in 3.1 above) must enabled as a Virtual Directory within IIS.  

Before the cgi-bin Virtual Directory has been created, in the IIS MMC it appears as a normal folder:

[image: image150.png]=lolx|

s wen | e o EE S

B28] =

ree |

R Tnternet Information Services

3 * ponaberver

3 vefaul e te

8 Defaul vieb Ste (Stopped)
8 adninstation Web St
8 porta server

Ed Explore

Sicor oen
8 st Browsz

8 Catslog
2% Default

& Defaut

Stop
Pause

T

Name Path

B cqitin Cricataloglcgivbin
com

3] aovo.cat

3] aoooo.cat

3] aovor cat

[ aovcz.cat

3] aooos.cat

3] aooos.cat

3] aovor.cat

3] actncshipping i
3] Act_AdrinEmal.xt
(9] act_pueremailixt
3] Act_CostomerEm,

Asie >
= N
G
Dokte (9] cataogbody el
Refresh o
e

(Create new virtual ¢ Properties





The Virtual Directory Creation Wizard appears:
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Click the Next> button.

Enter cgi-bin in the Virtual Directory Alias box:
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Then click the Next> button.

Browse to the cgi-bin directory, to be used in Web Site Content Directory via the Browse… button:
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Then click the Next> button.

Check Read, Run Scripts and Execute in the Access Permissions:

[image: image154.png]izard

virtual

irectory Creation

Access Permissions
‘What access pemissions do you want 1o se for tis vitual diectory?

Allowthe following

v Fiead

1% Run scipts (such as ASF)

¥ Execute (such as 154P1 appications or CGl)
™ wiite

T~ Browse

Click Next to complete the wizard.

Bk Cance





Then click the Next> button.

The "You have successfully completed the Virtual Directory Creation Wizard" window appears:

[image: image155.png]You have successfully
completed the Virtual

Click Finish to continue.

Firish

Directory Creation Wizard.





Click Finish button.

The icon on the cgi-bin should be created as the one pictured below:
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Note: The normal folder icon will most likely still be visible in the Web Site, doing a Refresh should remove the cgi-bin normal folder icon, and just leave the cgi-bin Virtual Directory.

cgi-bin IIS Check

In the IIS MMC expand the web site containing the cgi-bin directory and check the Properties settings:
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Check - A directory located on this computer.

Local Path: C:\Inetpub\wwwroot\Catalogsite\cgi-bin

Check - Read and log visits

Application name: cgi-bin

Execute Permissions: Scripts and Executables

Application Protection: Medium (Pooled)

cgi-bin Perl Association

Check the cgi-bin Perl association in IIS.

Right click on the cgi-bin virtual directory icon: 

Select Properties | Configuration | Application Configuration
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There should be only one entry for the Perl association and it should be:

Extension
Executable Path

.pl

C:\Perl\bin\Perl.exe %s %s

Note: the “s” of the %s %s are both lower case.

Verbs should be limited to: GET, HEAD and POST

NTFS Permissions – Catalog Home Directory

Open up Windows Explorer and drill down to the Catalog “Home directory” right click on it and select Properties:
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The Catalogsite Properties window is displayed.:
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Select the Security tab:
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Highlight the Everyone User and click on the Remove button and remove the Everyone User.

Click on the Add… button.
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Scroll down to the IUSR_hostname (in this example IUSR_PORTALSERVER) 

Click the Add button.

Select ftp User (in this example Shaun Sloan) and click the Add button.

Click OK.

The Catalog site directory permissions should look like:
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For the IUSR_hostname User (in this example IUSR_PORTALSERVER) the following permissions should be checked in the Allow column:

Modify

Read & Execute

List Folder Contents

Read

Write

For the ftp User (in this example Shaun Sloan) the following permissions should be checked in the Allow column:

Modify

Read & Execute

List Folder Contents

Read

Write

Click OK to exit the Catalogsite Properties window.

Acatalog Directory NTFS Permissions

The same permissions should be applied to the acatalog directory as the Catalog “Home directory”.  Highlight the IUSR_hostname User and check the permissions:
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IUSR_hostname should have the following permissions checked in the Allow column:

Modify

Read & Execute

List Folder Contents

Read

Write

The ftp User (Shaun Sloan in this example) should have the following permissions checked in the Allow column:

Modify

Read & Execute

List Folder Contents

Read

Write

The Everyone User should have been removed.

Click OK button to exit.

NTFS Permissions – CGI-BIN Directory

NTFS permissions for the cgi-bin directory have to also be set up.

Open up Windows Explorer and drill down to the cgi-bin directory, right click on it and select Properties:
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The cgi-bin Properties window is displayed:
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Select the Security tab:
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Highlight the Everyone User:
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Check the following Allow Permissions:

Read & Execute

List Folder Contents

Read

Uncheck:

Allow inheritable permissions from parent to propagate to this object.

FTP User 

Because the Everyone User permissions have been restricted it is necessary to give the user that will be used to ftp the files to the server write access to the cgi-bin directory.

Click on the Add button and select the appropriate user:
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Click OK.
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The following permissions should be checked for the ftp User:

Modify

Read & Execute

List Folder Contents

Read

Write

Click on Apply and then OK to exit cgi-bin Properties window.

Network Password Dialog-box

If an “Enter Network Password” dialog-box appears after clicking on the Add To Basket button:
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The Internet Guest Account does not have Read & Execute permissions on the cgi-bin directory.

Check the permissions are set as in section 7 above.

Web Sharing

Open up Explorer and drill down to the cgi-bin directory, right click on it and select Properties and select Web Sharing tab.  If there are multiple Web Sites then the will be a drop down list associated with Share on:, select the Catalog Web Site associated with this cgi-bin.
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The settings should be as follows:

Checked - Share this folder

Aliases – cgi-bin

Then click the OK button.

FTP Settings

In the IIS MMC, select the Default FTP Site or FTP site associated with Catalog, right click and select Properties.  Click on the Home Directory tab.

Check the settings are as below:
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Click the OK button.

Perl Association

To check the association of the Perl file extension (.pl) in Windows NT the following registry key needs to be checked:

LocalMachine\SYSTEM\CurrentControlSet\Services\W3SVC\Parameters\Script Map

The association should look like the following:
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The association should be:

Name

Type

Data

.pl 

REG_SZ
C:\Perl\bin\Perl.exe %s %s

Note: The “s” of %s %s are both lowercase.

Perl Checks

The following checks should be made to ensure that Perl is installed on the Server.

In a command window check that Perl is installed and will run:
C:\> perl –v
Output should look something like:
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Also in the command window check the path to Perl:

C:\> path
The output should be something like:
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Note: If the perl –v returns a message along the lines:

“‘perl –v’ is not recognised as an internal or external command, operable program or batch file.” 

is displayed then perl is most likely not installed.

If Perl is not installed, it can be downloaded from the ActiveState web site:

http://www.activestate.com/Products/ActivePerl/Download.html
Advanced – Network Setup

The Network settings should be as follows:
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Web Server Setup for use with Actinic Ecommerce

When using Actinic Catalog with Actinic Host the Shop Web site home page has the format something like:

 http://default_shop_url/index.html 

When running an Actinic Catalog in conjunction with Actinic Host two Web Sites have to be created in IIS:

The Host Web Site - http://host_site/

The Shop Web Site - http://default_shop_url
This is because all of the shops that are to be Host-based will run the same set of Perl scripts.

The Host Web Site should contain:

Virtual cgi-bin directory

The codebase/COM/Actinic/Catalog directory structure

The Catalog Web Site should contain:

Catalog directory

If any further shops are required, then a new Web Site has to be created for each new shop.

Defining The Home Page In IIS

The default home page in IIS is set to default.htm or default.asp, but Catalog uses index.html as the home page.

To add index.html open up the IIS MMC, right click on the Web Site and select Properties:
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The Web Site Properties box appears:
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Select the Documents tab:
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Click on the Add… button:
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Enter index.html and click the OK button.

Using the [image: image182.png]


 button move index.html to the top of the list:
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Click on the OK button.

Troubleshooting

cgi-bin Accessed Denied

There are occasions when access to the cgi-bin directory is denied after following the above guidelines. 

It may become necessary to delete the cgi-bin virtual directory in IIS and then the cgi-bin directory in Windows Explorer, and then re-create both and reapply the necessary permissions [image: image184.bmp]
Layout Name





Variable Name





Variable Group













































Advanced Users Guide - 3

_1056180504.doc
[image: image1.png]Office Fumiture







